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1. INTRODUCTION

1.1 Purpose and Scope

This document provides a detailed guide to using the EnviView tool for viewing data from
the Envisat mission. It explains how Envisat data can be extracted, decoded, and
displayed using various visual representations, including images where appropriate, and
exported in a variety of formats.

1.2 Structure of the Document

After this introduction, the document is divided into a number of major sections that are
briefly described below:

• Chapter 2 – The EnviView Application. The EnviView tool is introduced and this
chapter provides a brief introduction to the capabilities of EnviView.

• Chapter 3 – Getting Started Quickly with EnviView. This chapter provides a quick
start introduction to using EnviView, giving summaries of how to perform typical
tasks, by way of simple step-by-step examples. The following chapters describe the
tool and its capabilities and use in more detail.

• Chapter 4 – Description of the User Interface. The basic design philosophy is
explained here and a description of the user interface and concepts. This chapter
explains how data is loaded, how new windows on the data are opened and how the
data can be modified and saved.

• Chapter 5 – Viewing Data in Tables. Envisat data can be viewed in various forms of
tables. This section discusses how to use the different capabilities in EnviView for
examining the data in ASCII, Hex, or HTML formats.

• Chapter 6 – Viewing Data Graphically. This chapter describes how EnviView can
be used to display data in various type of graph.  It describes how to select data of
interest, assign data to the X- and Y-axes, and customise the display properties.

• Chapter 7 – Viewing Envisat Image Data. This chapter describes how EnviView
can be used to view, manipulate, and save image data taken by Envisat.

• Chapter 8 – Viewing Wave Spectra. This chapter describes how EnviView can be
used to view ASAR wave spectra data.

• Chapter 9 – Viewing 2-D Map data. This chapter describes how EnviView can be
used to view geo-location information.

• Chapter 10 – The Array Movie Viewer. This chapter describes a viewer used to
display a selectable number of multiple records in a single plot, which can be used to
easily compare data and track the development of features in subsequent records.
With this tool it also possible to display a sequence of records that are updated
continuously so that the plots are animated

• Chapter 11 – Saving and Exporting Envisat data. This chapter describes the
functionality in EnviView for extracting and saving data to different file formats.

• Chapter 12 – Decoding Level 0 Data. This chapter describes how to configure
EnviView to read information from Level 0 source packets.

• Chapter 13 – Getting help on EnviView. This chapter describes the help available
in EnviView, both on- and off-line.
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• 

• Chapter 14 – Command Line Tools and EnviView.  This chapter describes
command line utilities for exporting data to various files formats and for calibrating
Sciamachy data.

• Appendix  A – Installing EnviView. This appendix points to instructions for installing
EnviView.

• Appendix B – Processing EnviView Data with IDL. This appendix provides
examples of analysing and further processing of Envisat data in HDF format by the
commonly used commercial product IDL, or its derivative ENVI.

1.3 Referenced Documents

The following is a list of documents with a direct bearing on the content of this report.
Where referenced in the text, these are identified RD.n, where 'n' is the number in the list
below:

RD.1 ENVISAT : Mission & System Summary, ESA

RD.2 Envisat-1 Product Specifications, ESA-GS-2009.

RD.3 Envisat Payload to Ground Segment Interface Control Document (PGICD),
     PO-ID-DOR-SY-0032

1.4 Definitions of Terms

The following terms have been used in this report with the meanings shown.

Data Set A collection of data set records in an Envisat product.

Data Set Record A collection of data fields of certain sizes and data types.

Dialog A window that displays information or presents options to the user.

Focus The destination of keyboard input.

Java Runtime Environment The software required to run a Java application

Product An Envisat data file, in PDS format

View A manner of visualising data. e.g a Graph View or an Image View.

Table 1.1 List of Terms Used in this Document
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1.5 List of Acronyms Used in this Document

The following acronyms have been used in this document.

AATSR Advanced Along Track Scanning Radiometer

ASAR Advanced Synthetic Aperture Radiometer

ASCII American Standard Code for Information Interchange

ADS Annotation Data Set (time stamped processing data)

COTS Commercial Off The Shelf Software

DSD Data Set Descriptor

DDT Alcatel Product Data Dictionary Tool

EOS Earth Observation System (NASA)

ESA European Space Agency

GADS Global Annotation Data Set (not time stamped)

GIF Graphics Interchange Format

HDF Hierarchical Data Format

HTML Hyper-Text Mark-up Language (web page format)

IDL Interactive Data Language

IEEE Institute of Electronic and Electrical Engineers

JPEG Joint Photographic Expert Group (image format)

JVM Java Virtual Machine (also Java VM)

MERIS Medium Resolution Imaging Spectrometer

MDS Measurement Data Set (time stamped measurement data)

MPH Main Product Header

PDS Envisat Payload Data Segment (systems processing and archiving data)

PPM An image format common on Unix

SPH Specific Product Header

TIFF Tagged Image File Format

VM (Java) Virtual Machine (used to run java software. Also JVM)

Table 1.2 The List of Acronyms used in this document
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2. THE ENVIVIEW APPLICATION

The Envisat satellite carries a package of instruments to observe the Earth and its
atmosphere from space in a synergetic fashion, addressing crucial matters such as
global warming, climate change, ozone depletion and ocean and ice monitoring. Detailed
information about the mission is available at http://envisat.esa.int or RD.1.

Data acquired in orbit are transmitted to ESA ground stations, and undergo a number of
stages of processing, resulting in various data products. These data products are written
in a data format exclusive to the Envisat Ground Segment (Payload Data Segment -
PDS).

EnviView is a tool capable of opening and decoding Envisat data. It then displays the
contents as tables, graphs, or as images as appropriate.

2.1 Capabilities of EnviView

EnviView is a simple tool providing a first look at Envisat data files in the PDS format. It
has a simple to use graphical user interface for data exploration and visualisation. It is
intended for the following purposes:

• To be able to open any Level 0, 1b, Level 2 or auxiliary PDS data file, section 2.3.

• To determine and display the contents of a file and the value of any given fields in
any data set.

• To provide basic visualisation of data through simple 2D & 3D graphs and images.

• To visualise certain high level data sets in a meaningful manner where a graph
conveys little information, especially

• image data sets from AATSR, ASAR and MERIS.

• ASAR Wave spectra.

• RA2 Waveforms

• To provide a representation of the geographic coverage on a rectangular map
projection.

• To export selected data to HDF, ASCII or binary data files, for analysis in COTS tools
such as Mathematica, IDL, Excel, etc.

• To calibrate Sciamachy level 1B data

• To save the contents of a record as HTML text for inclusion in reports.

• To provide support for printing and system clipboard (cut/paste) where possible.

• To be highly portable and to reach as wide an audience as possible.

• To be guaranteed to run on Unix, Windows and MacOS and potentially other
platforms too.
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2.2 Limitations of EnviView

EnviView is not intended for detailed analysis, visualisation, and processing of Envisat
data, other commercial and proprietary tools provide these facilities in great detail and
with many specialised options. The difference between such tools and EnviView is that
they are either highly generalised, or aimed at specific classes of data, such as images or
atmospheric data, or even data for a particular instrument.

EnviView, however, is a single solution for all Envisat products. EnviView is intended as a
stepping stone between the proprietary data format used for Envisat data and other tools.

 Widely used commercial packages include: -

• IDL & ENVI http://www.rsinc.com

• Matlab http://www.mathworks.com

• Mathematica http://www.wolfram.com/

• Noesys http://www.rsinc.com

• PV-WAVE http://www.vni.com

2.3 Envisat / PDS Data format

To understand Envisat data files, one needs to know a little information about the
structure of files in the PDS format.

There are five classes of data files: -

• Level 0 products - raw data source packets from the satellite, wrapped in a PDS
compatible file structure.

• Level 1b products - geo-located engineering products, in which data has been
converted to engineering units. Auxiliary data has been separated from
measurements and selected calibrations have been applied to the data.

• Level 2 products - geo-located geophysical products, in which Level 1b data has
been transformed through higher-level processing into geophysical quantities.

• Browse products - low-resolution overviews of Level 1b and level 2 image products
provided for catalogue browsing.

• Auxiliary products - external data used at various stages of the ground processing,
including instrument characterisation measurements, calibration settings,
meteorological and orbit predictions.

All of these data products are written in the following structure: -

1. A Main Product Header (MPH)

2. A Specific Product Header (SPH) - including a number of Data Set
Descriptors (DSD), a directory of the remaining data sets in the file.

3. Measurement Data Sets (MDS) – time tagged measurements

4. Annotation Data Sets (ADS) – time tagged processing parameters

5. Global Annotation Data Sets (GADS) – unrelated to measurement time
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The format of the MPH is identical for all products. The SPH is specific to each product or
group of related products. Both the MPH and SPH are written in plain ASCII text. The rest
of the file is in binary format, except for a few products that also have ASCII ADS or
MDS.

Each MDS, ADS or GADS consists of a sequence of Data Set Records, containing one
or more fields of data. The format of these data sets is described in Product Specification
Documents and is also available within EnviView from the Help menu.

A measurement data set contains data derived from instrument measurements, and
related processing or instrument information. Every MDS has a time stamp indication the
time of measurement. An ADS contains processing information related to measurements,
such as Geolocation, or quality parameters, and is also time stamped with the time of
related measurements. The GADS contain processing configuration data that apply to the
entire product, and are not related to individual measurements, and hence have no time
stamp.

2.4 User Feedback & Bug Reports

User feedback is essential for improving EnviView and comments and bug reports can be
sent directly to the EnviView team via enviview@jw.estec.esa.nl, or via ESA EO
Helpdesk eohelp@esa.int.

When making a bug report, please include the following information:

• From the About EnviView option in the Help menu:-

• Operating System & Machine Type

• Java version, vendor name and vendor specific

• EnviView and data format version numbers

• Steps leading to problem

• Any text sent to the terminal

We would like to thank all those who were kind enough to send bug reports and feedback
in the past. Every message helps to make the tool better for everyone in the future.
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3. GETTING STARTED QUICKLY WITH ENVIVIEW

In the modern, fast-paced world of today, nobody, it seems, has time to RTFM1. The
EnviView graphical user interface has been designed to be as intuitive and as easy to
use as possible, but nevertheless some explanation of how to use it is necessary.

This chapter provides the basic information that is required to get started with EnviView
and look into data files, or products, view the data therein in an appropriate manner,
perform elementary processing of that data, and finally how to save the results. It is a
quick-start guide and provides essentially tutorial style instructions to perform the tasks
that are most commonly requested.

Each sub-section heading is in the form of a question, emphasising the quick start nature
of the material in this chapter. These provide the basics for using EnviView in a
productive and efficient manner.  Users are then encouraged to explore and experiment
with the possibilities provided by EnviView.

For a detailed understanding of the many features of EnviView, one can always RTFM.

3.1 How do I start EnviView?

The answer depends on the platform from where it is being run.

3.1.1 Windows or Macintosh platform

Start EnviView by double clicking on the application file icon

3.1.2 Unix platform

Start EnviView by running the shell script.

3.1.3 Any java platforms :

Start EnviView by executing the command :-

java -cp EnviView.jar envisat.EnviView

This requires that the Java 2 environment is already installed and set up correctly on the
platform that EnviView is to be executed, so that the command java is recognised. The
file EnviView.jar can be in any directory, but the path must be included in the above
command. Alternatively, the environment variable for the classpath can be pre-defined.

For java 1.1, the syntax of the java command is slightly different, and one must also
ensure that the swing library (version 1.1.1) is also present on the classpath.

java –classpath EnviView.jar:swingall.jar envisat.EnviView

Some java installations may use the 'jre' command to start a java application, instead of
‘java’. Please refer to the documentation with the java runtime.

                                                       

1 RTFM  - politely defined as “Read The Fine Manual”. Other definitions also exist.
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3.2 Is there on-line help available?

Yes, this manual is available from the help menu.  Some user interface elements may
also provide tooltips to explain their function. A tooltip is displayed when the mouse
cursor is held above a component (such as a button or a text field), and provides
information or instructions pertinent to that component and it’s use.

3.3 What happens when EnviView starts?

When EnviView starts a new window is created. Until a data file is opened, it has the title
EnviView, Figure 3.1

Figure 3.1 The opening window when EnviView starts

The window has menus but most of the options are disabled. At this stage it is possible to
consult the on-line help, set user preferences (section 3.19), see the Envisat data formats
(section 4.3.6) and of course Open and load a data file, Figure 3.2.

Figure 3.2 The opening window with the open option.
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3.4 How do I locate and load data files?

A data file can be opened from any EnviView window, even if that window already has a
data file loaded, through the Open option of the File menu (Figure 3.2 and section 4.3.1).
Once selected, a file chooser is displayed, which allows the local directory structure to be
navigated and the desired file found and selected.

Note that there is a bug in some versions of the Java environment where the default
directory in the viewer does not necessarily correspond to the files listed which may be in
a different directory.

When a file is selected – a new window is opened, with the same name as the data file,
and more options in the menus are enabled, depending on the file type, e.g. Figure 3.3.
Of most interest is the fact that it now possible to open views on the data i.e. inspect the
data in different ways.

NOTE: for best performance, copy data files to the local hard disc before opening.
Loading files from CD-ROM or from a network disk will result severely impair reaction
time for displaying data.
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3.5 How do I examine a product’s structure?

When a file is opened, there is one view that is opened by default, namely the File View.
This shows a list of all the data sets in a product. They are displayed in a tree or
hierarchical layout showing the large-scale structure of a file and showing the headers
(MPH and SPH) and what kind of data set it is, i.e. either measurement, annotation, or
global annotation data sets, e.g. Figure 3.3.

One can examine the format if any Envisat product without opening a file, by selecting
the Product Formats option, from the Help menu.

Figure 3.3 The File View in the EnviView window

The File View is a table with three columns that shows: -

• the data set description

• the number of records for a given data set

• and the total size of the data set in bytes

This view only shows the top-level elements of an Envisat file.
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To see the contents of the individual fields and sub-fields in a data set, use the Record
View. This is displayed by selecting the New Record View in the View menu (section
4.3.3). This provides a table containing the fields and their values of a single record in a
data set. Each view has a named tab, at the top of the window. Views may be
interchanged by clicking on the tabs.  The data set displayed in a given record view may
be changed through the use of a pop up list labelled Data Set. Any record in a data set
may be displayed, by moving a slider, or typing the index of the record in a text box, see
Figure 3.4.

Figure 3.4 A Record View

3.6 How do I find and open a data set?

There are two ways, once a file has been loaded : -

• a File View is opened (Figure 3.3), which is a simple tree-like view of a products
structure and it lists all the data sets in the file, including MPH and SPH. Once the
desired data set has been located in the tree, it can be examined in more detail by
double clicking on the data set name.

• Alternatively, the New Record View option from the View menu can be selected
which creates a view of the MPH. This has a selection box labelled Data Set at the
top of the window with the list of all the data sets in the file, from which the desired
one can be selected and examined.

A more descriptive look at a records contents is provided by the HTML View (section
5.4). A description of the format of all Envisat data products may be browsed by selecting
the Envisat Data Formats option from the Help menu.
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3.7 How do I examine the fields in a data set?

First load the data file and select the data set, section 3.6. The result is a record view
which displays the fields in the data set in a table of four columns : -

• the index column simply provides the index of the field,

• the second column gives the Field Name,

• the actual field value is in the third column,

• and the final column shows the units for the field, if there are any.

If the field name is highlighted in blue, holding the mouse pointer over the name will pop
up a description of the field quantity. Likewise, if a field value is highlighted in blue,
holding the mouse pointer over the value will pop up a window with an alternative
representation of the values.

An optional fifth column, containing the raw bytes of a field in hexadecimal may also be
displayed. This column is switched on or off from the View menu. Select Show Raw
Bytes Column from the sub-menu Record View Options, to display the extra column.
Select Hide Raw Bytes Column to return to the default set of columns.

The columns can be resized, simply position the cursor over the dividing line between the
columns. When the cursor changes to a double-headed arrow, click and hold down a
mouse button and adjust the column as desired. The column order can also be adjusted;
click and hold down a mouse button over the column header, and drag the column over
to the desired location.

The view will have a scroll bar at the right hand side to scroll through the data set
enabling all the fields to be examined.

For fields which have multiple elements, both the field name and field index for each
entry have an index appended to them enclosed in square brackets.

For fields with sub-fields, the name of the sub-field is appended to the field name
separated by a full stop or decimal point and displayed in the Field Name column. The
index of the sub-field is appended to the field index, again separated by a full stop, but
note sub-field indices are given as alphabetical references not integers.

3.8 How do I compare the data in different records?

3.8.1 Comparisons by Graphs

The comparison depends on the type of data. For scalar fields, that is a single value per
record, a plot of n records will show the trends in the data. For array fields, i.e. many
points per record, a single record is displayed per plot. To look at subsequent records,
EnviView allows the source record index to be updated without changing the field
settings. To visually compare two records simultaneously, a second plot view can be
opened (choose New Simple Graph View from the View menu). While this latter method
has two plot views, by default, only one can be seen at a time. The solution is to open a
new window on the data with the New Window option in the Window menu. One view
may then be selected in one window, and the other view in the second window.
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Alternatively, a new Plot Window may be opened via the Plot menu, and data from
different records may be extracted an plotted on the same graph. See section 6 for full
details.

3.8.2 Comparisons in Tables

First load the data set and open the Record View, Figure 3.4. Find the particular range of
data of interest, then using the controls to change records, (see Figure 5.2) navigate
through the records.

To visually compare two records views simultaneously, open a new window on the data
with the New Window option in the Window menu, and a second record view from the
View menu One view may then be selected in one window, and the other view in the
second window.

3.9 How do I view the raw data in a record or field?

When working on I/O routines to access data files directly, or to understand how a data
value is represented in an Envisat file, one may wish to view the raw bytes making up a
field or a record.

To view the raw bytes of an individual field, the Record View, provides an optional fifth
column, displaying the raw bytes of a field in hexadecimal. This column is switched on or
off from the View menu. Select Show Raw Bytes Column from the sub-menu Record
View Options, to display the extra column. Select Hide Raw Bytes Column to return to the
default set of columns.

Figure 3.5 Showing Raw Bytes
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The Hex Dump View, shown in Figure 3.6, displays the actual bytes making up the data
in an entire record. It contains three columns. The first gives the byte offset, in hex, at the
start of the row of data. The second column shows the hex value of each byte, with 16
bytes per row divided into four four-byte words. The third column gives the ASCII
translation of the hex dump. Note that columns can be neither resized nor rearranged in
the hex view.

Figure 3.6 The Hex Dump View

3.10 How do I plot a graph?

See Chapter 6 for full details.
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3.11 How do I view an image?

If an open product contains image data, a New Image View option is enabled in the View
menu. An image view allows any quantity in any data set to be displayed, see Figure 3.7.

Figure 3.7 An example image view

If multiple quantities or data sets are present in a product, a second quantity may be
overlaid on top the first for comparison. The colour scale may be changed to enhance the
image’s appearance. For more information, refer to Chapter 7.

The AATSR level 2 averaged surface temperature product does not contain image scan
lines, and hence can not be displayed in the image viewer. It's data may be displayed
using the 2-D map view (see Chapter 9 for details).

NOTE: for best performance, copy data files to the local hard disc before opening.
Loading files from CD-ROM or from a network disk will result severely impair reaction
time for displaying data.

3.12 How do I view Geolocation data?

If a file has a geolocation ADS, the option New 2-D Map Viewer will be enabled in the
View menu. The map view displays a world map using a simple rectangular projection,
see Figure 3.8. Any field in a data set containing geolocation information may be
displayed on the map. The area displayed may be modified by clicking and dragging the
mouse over the desired region, or modifying the axes ranges. Please see Chapter 9 for
details about the functions in the viewer.
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Figure 3.8 An example of a 2-D map view

3.13 How do I view Radar Altimeter waveform data?

From the View menu select the New Array Movie Viewer option. This option is available
for any data sets with fixed length arrays. A selected array field (e.g.
ave_ku_wvform_corr from the RA2_SCIENCE_LEVEL_1B data set) may be displayed
from subsequent records, see Figure 3.9.  Basic animation functions are provided for
visualising the development of the waveform from record to record. See Chapter 10 for
details about the view. 
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Figure 3.9 An example of the Array Movie View

3.14 How do I subset and calibrate Sciamachy level 1B products?

Either using the special Sciamachy calibration function from the file menu (see section
11.3) or by using the command line tool SciaL1C (see Chapter 14).

3.15 How do I export Envisat PDS data to HDF?

Use the Save as HDF function, described in chapter 11, or the command line tool
Pds2Hdf, which is explained in more detail in chapter 14.

3.16 How do I see two views simultaneously?

To be able to see two or more views simultaneously, simply choose the New Window
option from the Window menu.

Figure 3.10 The window menu
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3.17 Can I use EnviView functions from the command line?

The following tools are provided in the standard EnviView package (version 2.0.1).

• Pds2Ascii – extract field values to an ASCII text file

• Pds2Hdf – extract datasets (and subsets) to an HDF 4 file

• PdsSubset – extract datasets to a smaller PDS child product (i.e. Pds2Pds)

• PdsPixels – extract portions of image datasets to various image file formats

• PdsPixelTrack – extract individual pixels from an image data set, along a given track

• SciaL1C – extract and calibrate Sciamachy measurement data

All tools have a similar syntax for options and arguments on the command line. They are
all described in detail in Chapter 14.

3.18 How do I process multiple commands in a batch job?

All EnviView command line tools can be run in a batch mode, i.e. with a set of commands
in a text file that can be executed sequentially and automatically.

e.g. if they are written in a file called batch.txt, they can be executed so :-

> Pds2Hdf –batch batch.txt

> SciaL1C –batch batch.txt

The main advantage of using the batch command line argument, instead of a shell script
or DOS batch file, is that the removal of the significant overhead to restart the java
runtime for each command. i.e the batch command line argument is much faster.

More details are provided in Chapter 14.
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3.19 How do I set preferences in EnviView?

Select Preferences from the Edit menu.

Figure 3.11 Opening the preferences dialog

The list of options that may be modified appears in the left hand column. This has three
options, one to configure the Image View, one to save the current working directory for
the next session, under the Files option, Figure 3.12, and one to select the “look-and-feel”
of EnviView.

Figure 3.12 Preferences window

The File Dialog preferences allow the user to enable (default) or disable that EnviView
remembers the last directory visited, each time it is quit. When EnviView is run again, if
the option was enabled, the open dialog will default to the last visited directory.
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3.20 How do I customise the appearance of EnviView?

Select Preferences from the Edit menu, and then Look & Feel in the list on the left. Three
options are available

• Native Look and Feel – this uses the look and feel of the operating system upon
which the application run.

• Default Look and Feel – this uses the java default look and feel for your platform.
This is configured in the properties file in your java runtime (see your java
runtime documentation for details).

• The final option is actually a selection box with any “look and feels” available on
your platform. These may include  : -

• Metal – a design specific to Java.

• CDE/Motif –  the X Windows Motif appearance

• Windows – only available when running under Windows

• MacOS - only available under MacOS 9 or X.

If the default settings are not attractive, simply experiment with different settings.
Note that the changes do not take effect until EnviView has been restarted.

The Mac OS 9 look & feel is not a perfect implementation, particularly the file dialog.
Under Mac OS 9, EnviView works best with the Metal look & feel.
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4. DESCRIPTION OF THE USER INTERFACE

This chapter explains some of the basic and common themes in the user interface for
EnviView.

4.1 Views and Windows

The EnviView graphical user interface allows a user to display the data contained in a
Envisat data file in a variety of ways, namely in textual, graphical, and image formats.
The interface presents these views of the data together in a single window.  The views
are effectively overlaid on top of each other but each view can be accessed by a tab label
attached to it, see Figure 3.4 for an example.

A new window is created for every data file opened and all views of the data are
displayed in this window.  Each window has the name of the data file that is displayed
therein.

It is also possible to create duplicate windows for the same data file. The window titles
are appended with a unique identifier, namely a colon followed by an index that is
increased as duplicate copies are opened.

By opening two windows on the same data file, separate views may be examined side by
side. For instance an image view could be open in one window, and a record view in the
other, all from the same file.

These windows and views, of which there could potentially be many, are managed from
the View and Window menus available in each windows menu bar. Essentially, the menu
choices allow easy navigation between views and windows, the creation and closing of
the different views themselves and opening of new products. The menu options are the
same for each window opened. Certain options are enabled or disabled depending on the
data file to which they refer. These are discussed in more detail in section 4.2.

4.2 Tabs

EnviView uses tabbed pages to organise the different data views created by a user. Each
time a new view is opened, either by selecting an option from the View menu (section
4.3.3) or some other method (e.g. section 5.2), another tabbed view is added to the
display. The tab is labelled with the view name. If more than one view of the same type is
opened, a unique integer suffix is appended.

Simply clicking on the tab brings that view to the front, but views can also be brought to
the front by selection the View name at the bottom of the View menu (section 4.3.3).

4.3 Menus

Clicking on one of the menu options at the top of each window (or screen) displays a list
of options of which only one can be selected at a time.  The items in each list are
identical for each product. However, some of them are disabled, or “greyed out”, if they
are not available or not appropriate.  Each window keeps a record of which other
windows are opened and which views are currently open. The different menu items, their
options, and their functionality are discussed in more detail below.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 28 of 141

4.3.1 The File menu.

This menu has 7 options;

• Open –opens a new data file. When selected a file chooser opens in a separate
window.  The details of the file chooser depend on the operating system under which
the application is being run.

• Close –closes the current file. All duplicate windows for the same file are also closed.
To close only one duplicate window, select Close from the Window menu. Naturally,
this option is only enabled once a file has been opened or loaded.

• Export to Hdf –export an Envisat product to HDF 4. This option is only enabled once
a file has been opened and if the HDF library has been correctly installed. See further
explanation in Chapter 11.

• Sciamachy Calibration – calibrate and subset a Sciamachy level 1B product,
creating a level 1C product. This option is only enabled once a SCI_NL__1P file has
been opened or loaded. See further explanation in Chapter 11.

• Page Setup – this option is intended to open a page setup dialog to configure
printing. It is only functional on certain platforms.

• Print – this option opens a platform specific print dialog, provided by your java
runtime. This option is only enabled if the currently open view can be printed.

• Quit – this ends the current EnviView session and all views and windows are closed.

When EnviView is started, only the Open and Quit options are enabled. The window is
simply labelled “EnviView”.  The window title is updated as soon as a data file is loaded.

Figure 4.1The File menu

4.3.2 The Edit menu.

This menu has several options of which only the Preferences option is available at all
times. The others, namely Undo, Cut, Copy, and Paste, are enabled when selected text
may be copied to the System clipboard, for exchange with other applications. The Cut
and Paste functions are naturally only enabled in editable fields. The Copy function
however is available whenever any text is selected. The Undo function is not currently
available.
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Figure 4.2 The Edit menu

The Preferences option allows the appearance of EnviView and some of its behaviour to
be customised, see section 3.19 for more information.

4.3.3 The View menu

This menu has a number of sections to it, separated by lines for clarity.

Figure 4.3 The View menu

• The first section allows new views to be created. Only views that are appropriate for
the currently open file may be selected. These options are shown in Figure 4.3. If
more than one type view is created, an integer will be appended to the view name so
that they can be distinguished from one another. The views available are :-

• New Record View – shows the contents of one record, section 5.1.

• New HTML View – shows the contents of one record in a formatted HTML table,
and includes a full description for every field, section 5.4.

• New Hex Dump View – shows the contents of one record as a hexadecimal
dump of the bytes, section  5.5.

• New ASCII View – display the contents of ASCII data sets, section 5.6.
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• New Image View – examine and manipulate image data, chapter 7.

• New Simple Graph View –a view where fields from a single data set can be
plotted, chapter 6.

• New 2-D Map View –a simple graph to plot geolocation information, chapter 9.

• New Array Movie View –a graph for array data, in particular Radar Altimeter
waveforms, chapter 10.

• New ASAR Wave Spectra View – opens a new view for ASAR wave spectra,
chapter 8.

• The second section is a list of views already created for the current data file and is
automatically updated as new views are opened. The view name is identical to the
identifier used on the tabs and this provides an alternative method to switch views.

• An optional third section may appear for some views with a submenu for view options
(e.g show raw bytes column for record view).

• The final section offers the option to close whichever View is currently open (note this
does not close the Window).

4.3.4 The Plot menu

The Plot menu opens a new window allow greater flexibility in plotting data than the
Simple Graph View. See Chapter 6 for more information.

4.3.5 The Window menu

Like the View menu this has a number of sections, see Figure 4.4.  This example shows
the Window menu pop-up when two files are already opened.

Figure 4.4 The Window menu

• The first is New Window  that will make a duplicate of the present window with the
same data file.  If selected, the two windows have the same name appended by a
unique integer identifier. Views created in either window will appear in both windows.
This allows views to be easily compared side by side on screen.

• The second section contains a list of the opened windows.  Selecting of one of these
will bring the window to the front and make it active.
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• The final option is simply Close, which closes this window. If no other windows are
open for the current file, the file and all the views contained are also closed. Duplicate
windows open on the same file are unaffected.

The list of open windows is automatically kept up to date.

4.3.6 The Help menu

This menu option currently offers two options.

Figure 4.5 The Help menu

• About EnviView, which creates a new pop-up window with information about the
current version of EnviView. It also displays information about memory being used.

• Envisat Data Formats – this opens a new window which allows the details about data
formats for different products to be examined.

The other options will provide links to the detailed handbooks for the instruments on
board Envisat. However, at the current time these are not available.

When reporting a bug or requesting support, please copy the contents of the
About EnviView box into your e-mail. (Use Ctrl-C to copy the selected text).
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5. VIEWING DATA IN TABLES

Table views show Envisat data as text. Any type of Envisat data can be viewed in a table
format and this is the default way of viewing the data. Three table view formats are
available, depending on how the data is to be used. Each of the views is optimised for a
different use.

• Record View (Figure 3.4)
This is the default view showing the fields of a single record as a table in a
spreadsheet like way. Each row shows a single field with 4 columns showing the field
index number, the field name, the value in scientific or engineering units and finally
the units. This view is good for viewing and comparing the actual values of fields. If
additional description is also available for a given field, the field name is highlighted
in blue. Hovering the mouse pointer over the field name displays the additional
description. An optional fifth column displays the raw bytes for each field.

• HTML View. (Figure 5.6)
This view shows a record in a two column table. The first column gives the full field
description whilst the second column gives the field value or array values and
summary (only sample values if there are many array elements). This view is useful
for viewing the descriptions of fields together with their values, which helps to
understand the layout of a product type.

• Hex Dump View (Figure 5.7)
This view shows the actual bytes making up the data in a particular record. It
contains three columns. The first gives the byte offset, in hexadecimal, at the start of
the row of data. The second column shows the data in hexadecimal with 16 bytes per
row divided into four four-byte words. The third column gives the ASCII translation of
the hex dump. This view may be useful when one is developing one’s own decoding
software.

• ASCII View (Figure 5.8)
This view displays the contents of ASCII data set records. All products have an MPH
and an SPH, and a few products have additional data sets that are also stored in
ASCII format.
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5.1 Tabular View features

From a File View of the data product, double click on the data set, which will create a new
Record View containing the data in a table.

Figure 5.1: Table View Feature Summary

Every table, be it in a Record, HTML, Hex or ASCII view, contains a set of controls for
navigating through and selecting the data being displayed, Figure 5.2.

Figure 5.2 Table view controls

The controls are divided in two vertical sections. At the top is a selection box with a pop-
up list of the data sets in the product that can be displayed in the current view. Selecting
a data set loads the data for a single record into the table.

Below the data set list, on the left hand side is a text field containing the currently
displayed record number. Any record number can be entered here, assuming it is a valid
number and valid value for the data set. The record’s data will be displayed after pressing
enter. To change record, back and forward buttons can be used to increment or
decrement the record counter by a single record, or for larger changes a slider can be
moved left or right. The record index in the record number field is updated accordingly.

The following features are also available in all views: -

• Creating a new view of the same or different data by selecting the New view in the
View menu.
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• View tabs, for quick navigation between multiple open views within the same data
product. Also the View menu may be used to switch between currently open views,
section 4.3.3.

The following features are specific to record views

• Resizing column widths by using the mouse to drag the column divider to the left or
right.

• Changing column order by dragging the column headers.

• Displaying extra field description by hovering the mouse pointer over a field name
highlighted in blue.

• Displaying alternative value formats by hovering the mouse pointer over a value
highlighted in blue.

• Optionally display an extra column containing the raw bytes for each field.

5.2 Creating a new view

To create a new view of the data, select the View menu and then a New View item (either
Record, HTML, Hex or any of the other views available). The example in Figure 5.3
shows a how to create a new hex dump view.

Figure 5.3  Creating a New View using the menu

The alternative way of creating a new record view is to double click a data set in the File
View. Click the File View tab to select this view. Then double-click on the chosen data set
and a new Record view of the data is created.
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5.3 Switching between Views

Only one view of the data is displayed at a time per EnviView window. To switch between
them use the tab selectors at the top of the window, below the EnviView menu bar.
Clicking a tab brings the corresponding view to the front. Figure 5.4 shows how to switch
from an HTML view to a Hex Dump view.

Figure 5.4 Switching Views using Tab selectors

An alternative way to switch views is to use the View menu. The View menu also
contains a list of all the open views, see section 4.3.3. The currently displayed view is
indicated with a tick. Select the view to display from the other views on the list. Figure 5.5
shows how to select a Hex Dump view from the view menu. This view switch is identical
that shown in Figure 5.4.

Figure 5.5 Switching Views using the View menu

5.3.1 Changing the data set within the same view.

To view a different data set (within the same data product) without opening a new view,
select the data set from the Data Set popup menu, which shows a list of all the data sets
that may be displayed. Selecting a different data set updates the information in the
current view. For instance if a Hex view is displayed of a particular data set, selecting a
different data set will display the contents of the selected record of this new data set.
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5.3.2 Closing a view

Select the view to be closed either using the tab selectors or the view menu (e.g. Hex
Dump View 1). Then from the View menu, select Close Hex Dump View 1 item. Note that
the close view menu item for the currently displayed view is always the last item of the
View menu.

5.3.3 Using Multiple windows

It is sometimes useful to see different views of the same data or different data sets within
the same product side by side. To do this, a new window must be created. Select the
New Window item from the Window menu. A duplicate window opens with exactly the
same views as the original. In each window, select the views of interest.

5.4 HTML View

Figure 5.6 shows an example of the HTML view. The data area shows an ESA/ENVISAT
logo below which is the data product name, the number of records and the number of
fields per record for the data set. Below this is a two-column table, which lists the field
names in the first column with the value and units in the second column. Each row in the
table corresponds to one field of a record.

Figure 5.6 Example HTML view

This view provides a more detailed description of each field than the standard Record
View, and may be saved to an HTML file for inclusion in reports. Note that long array
fields are summarised in this view, to reduce the rendering time required. For full analysis
of array fields, use the Record View.
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5.5 Hex Dump View

This view shows the raw bytes of each data set record. It contains three columns. The
first gives the byte offset, in hex, at the start of the row of data. The second column
shows the hex data with 16 bytes per row divided into four four-byte words. The third
column gives the ASCII translation of the hex dump. Note that columns can be neither
resized nor rearranged in the hex view.

Figure 5.7 Hex Dump View example

This view may be useful for developers of software to read Envisat PDS format products
directly, so that they may verify their results against those obtained in EnviView.
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5.6 ASCII View

This view displays the contents of ASCII data set records. This view cannot display
binary data sets, for which a Record View, HTML View or Hex Dump View are better
suited.

All products have an MPH and an SPH which are always written in ASCII, and a few
products have additional data sets that are also stored in ASCII format.

Figure 5.8 ASCII view example
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6. VIEWING DATA GRAPHICALLY

6.1 Introduction

EnviView has two methods for displaying data Graphically. The simple graph viewer, see
section 6.2, can be used to display fields from a single record in a quick and simple
manner. For more advanced graph plots, and for combining data from multiple data sets
and/or products, an extended data extraction and plotting facility is available, see section
.

6.2 What is the Simple Graph Viewer

The Simple Graph Viewer displays one or two data set field values plotted against the
record index or other field values, as line graphs.

6.2.1 Quick Start

Open the required data product. The File View opens showing a list of data sets. Select
the View menu, New Simple Graph View menu item (as shown in Figure 6.1).

Figure 6.1  Starting a new simple graph view

A new simple graph view will open (similar to that shown in Figure 6.2). EnviView
automatically chooses the first valid data set (for plotting) however no data is plotted. At
least one Y field must be chosen to plot using either the Y’ field or Y field pop-up menus.
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Figure 6.2 A new Simple Graph View

6.2.2 Feature Summary

Figure 6.3 shows an example of a Simple Graph View window showing the values of two
fields plotted against record index number. This section briefly describes the features and
controls available for Graph views. More details are available in the sections that follow.

Figure 6.3 Simple Graph View example with data

The features available moving from the top towards the bottom of the window are;

• Menu bar and Menus.
These are identical to those on other windows
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• View tabs.
These select other open views with a single mouse click.

• Data Set Selector.
This displays the name of the current simple graph data set, in the data product, allowing
selection of other data sets displayable by the simple graph viewer. See section 6.2.4.1
for more details.

• Record Selector Controls and indicators.
These consist of the Record field which displays the record number of the lowest
displayed record. A record number can be entered into this field. The nudge back and
forward buttons allow movement through the data set one record at a time and the record
slide control allows a quick location to a particular part of the data set. The Records/Plot
field shows how many records have their data plotted on the current simple graph. This
field can be edited. See section 6.2.4.2 for more details.

• Field Selector controls.
These controls allow selection up to 2 field values to plot on the vertical Y axis and also
selection of the X-axis field against which to plot the Y values. See section 6.2.4.3 for
more details.

• Plot point style selector and indicator
The point style pop-up menu selectors display the current symbols used to plot points.
Use the pop-up menus to select different point styles. See section 6.2.5 for more details.

• Data Area
The data area displays the plot, the vertical Y axes (or axis) and the horizontal X-axis.

• Identification and Information Area. See section 6.2.5 for more details.
This area, at the bottom of the window, displays which records the data plotted comes
from, the data set name, the X-axis field, the plot symbols and fields for the Y-axis and
finally the File title (that corresponds to the data product).

6.2.3 Array vs Scalar fields.

It is important to appreciate that there are two types of field data that can be plotted in
EnviView: -

• scalar fields: These are fields which have a single value per record in the data set. To
be meaningful, a plot using these data will be of the data value for multiple records.

• array fields: These are fields with multiple values (i.e. arrays) per record. Therefore,
each line on a plot has the data for a single record (usually there will be a single
curve per plot, but more are possible).

Most of the functionality of the Simple Graph Viewer is independent of the field type, such
as data set selection and field selection and is described in the following chapter.
However, it is important to understand the difference so that the resulting plots can be
understood.

6.2.4 Selecting Data to Plot

This section explains, in detail, how to select data to plot on simple graph view. The
major steps are listed below. Note that once a data set is selected, the remaining steps
can be carried in any order and then the settings can be interactively altered once the
graph is being displayed;

• Select the data set which contain records to plot.
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• Select the record from which the plot is to start.

• Select how many records should appear on the screen.

• Choose the X field (the default is record index).

• Choose the field within the record to plot on the Y scale. 1 or 2 fields can be selected.

6.2.4.1 Selecting a data set

The data set pop-up menu, towards the top of the window, contains a list of plottable data
sets for the product. It displays the name of the data set that is currently being viewed. To
select a different data set (if available), click and open the pop-up menu and select the
data set required.

Data sets must contain 2 or more records in order to be viewable with simple graph
viewer.

6.2.4.2 Selecting Records

Once a data set is selected, the range of records from which to display data can be
chosen. The controls to do this are shown in Figure 6.4. Note, the figure has blurred the
parts that are not relevant to this discussion.

Figure 6.4 Record Controls

Select the record from which the plot is to begin. This can be done in several ways;

• If the record number of the first record to plot is known, type it into the Record field.
Select the record field and enter the value using the keyboard. Remember to press
Return. The record slider, to the right of the record field, will move to the
corresponding position of the record.

• Use the nudge back and forward buttons (between the Record field and the record
slider) to move through the data set one record at a time.

• To browse through records or know the approximate position of the data, in the data
set, drag the record slider to the corresponding position. If the data set contains a
large number of records use the nudge back and forward buttons to move a single
record at a time to the precise start record required.

Select the number of records per plot. Usually this will be the same as the number of
points per line on the display. Follow the steps below;

• Select the Record/Plot field.

• Enter how many records are to be displayed per plot into this field.

• Remember to press Enter to see the changes applied

The number at the right hand end of the record slider (11 in the case of Figure 6.4) is the
highest start record from which a plot can begin. This is the same as the number of
records in the data set if only 1 record is plotted. In this example the data set contains 20
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records;10 records are plotted (Records/Plot field) so the lowest start record is 11,
because the number is inclusive, i.e.

Lowest start record = Number of records in data set – Records/Plot +1

Note that a graph can be displayed containing data from just one record so long as the
field being plotted is an array field, see section 6.2.6 for more details.

6.2.4.3 Selecting Fields

To choose the fields to display on the simple graph viewer, there are controls to do this
and to control the look of the plotted points, see Figure 6.5.

Figure 6.5  Field controls

The default X field (plotted on the horizontal X-axis) is the record index. However, this
can be altered to any available data field in the record. This is useful to plot two data
fields against each other.

Select the X-field pop-up menu to display list of available fields. Select the field to be
plotted on the X-axis from this list.

Initially no data fields are selected for the Y axis. At least one Y field must be chosen to
plot a graph. Up to two line graphs can be plotted simultaneously by the simple graph
viewer. Both lines are plotted against the same X-axis field.

Select either the Y’ field or Y field pop up menus to display a list of available fields. From
the list displayed, chose the field to plot on the Y-axis. Note that record index is not
available as a Y-axis field. Alternatively, another Y-value can be plotted chosen from the
other Y or Y’ field pop-up menu to display a second line.

6.2.5 Changing the display of graphs

The look of the graph being displayed can be modified in several ways, listed below;

• Point style selection

• Changing the axes scales

• Resizing the graph.

To alter the symbol of the plotted points associated with each line, use the pop-up menus
to the right of the Y and Y’ Field pop-up menus (see Figure 6.5). 7 styles are available
starting with a plain line, having no point symbol, which is the default setting.

The scales of both the  X,  Y and Y’ axes can be altered. EnviView scales the axes to
maximise the screen area on which the graph is plotted by default. However, it also
allows scales to be set manually, which is useful for instance to emphasis a certain
region of the data. The process is similar for all 3 axes.

Double click the axis that to be changed. A dialogue box opens, similar to that shown in
Figure 6.6.
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Figure 6.6  Changing the simple graph axes scale

To let Eniview choose the scale, maximising the axis length used by the plot make sure
the Auto radio button is checked. To set the scale manually, set the Manual radio button
and enter the values for the start and end points of the axis in the From: and To: text
fields. Click the Apply button to see the changes take effect. If the Exact check box is left
unchecked, EnviView may round the values entered.

This procedure is the same for each axis. Note that the Y’ axis appears at the right hand
side of the plot with the Y axis at the left hand side. Changing the X-scale range to be
larger than the record range plotted does not increase the number of records plotted.
This just displays the same number of records (defined in the Records/Plot field) in a
smaller area.

To increase the screen area of the plot, increase the window size by maximising it or
dragging a resize control. (The details of this depend on the Graphical User Interface
being used). The plot will be resized to make use of the increased window area.
Conversely decrease the window size to shrink the area of the graph plot.

6.2.6 Viewing Array Field data

One-dimensional field arrays can be viewed in simple graph viewer. These plots can plot
the field array data from several records at a time. Figure 6.7 shows a simple graph view
of a field array. Only one record/plot is shown and the X-axis shows Array Field Index [n]
instead of Record number.

Figure 6.7. Simple graph view of a field array
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These are the steps to display a field array, for just one record, on a simple graph view;

• Select a data set containing array fields.
To find out whether a data contains array fields, view it in the HTML or Record views
and check the field characteristics.

• Select the record to be viewed.

• Set the Record/Plot fields to 1.

• Select the X-field to be Array Field Index [n]

• Select the Y-field (or fields) to be the field array to be plotted

Navigating through the records, using the record controls, causes the plot to be re-drawn
to show the field array values for the record selected.

6.2.6.1 Comparison with the Array Movie viewer

The Array movie viewer can produce a similar display to that of a field array in the Simple
Graph Viewer.  Figure 6.8 shows the same data as plotted in Figure 6.7 in an array movie
viewer.

Figure 6.8 Array movie equivalent

These two different viewers are designed for different uses even though they can
represent the data in similar ways. Generally the following guidelines apply to the choice
of which viewer which should be used.

• To compare arrays, from different records, use the array movie viewer.

• To compare the array field with another field in the same record use the simple graph
viewer

See chapter 10 for details about using the array movie viewer.
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6.3 Extended Data Extraction and Plotting

The plotting and extended data extraction facility allows users to extract data from
multiple locations and plot them in a number of different ways. Extended data extraction
is explained in section 6.3.2. There are several ways to display the data, each of which is
explained further in section 6.3.3.

6.3.1 What is Extended Data Extraction

The simple graph viewer allows data from a single data set to be examined quickly and
easily. For more advanced data analysis, the extended data extraction facility provides a
method for extracting data from various data set records, and even from multiple files.
These variables can then be plotted in various ways. The following sections explain how
to go from extracting data to plotting a graph.

There are two formats EnviView uses in the extraction and viewing of data. The first
format is the "variable". A variable is a set of data extracted form a data set. It can be
used in multiple graph data sets. The second format, which is a graph data set, is a set of
variables configured for display on a graph type. For example a variable may be the
"bad_pixel_mask" field from the PPG/ELATON" data set record in a Sciamachy L1B
product. This can then be set against its index variable to be a line (graph data set) on a
two-dimensional line graph.

6.3.2 The Graphing Components

There are two types of graphs, a set of pre-configured graphs for each product
(discussed in section 6.4), and a set of blank graph types discussed below:

• 2D line graph: This is a graph with multiple lines plotted on a two dimensional plane.
Each line, representing a graph data set, can have an interpolation type, linear or
spline. A marker line can be added to the graph to guide the eye.

• 3D line graph: This is a graph with multiple lines plotted in a three dimensional
plane.

• Pie Chart: This graph type can only be used to plot single one-dimensional data
sets.

• Bar Chart: This is a graph which can represents multiple one-dimensional data sets.
The bar sets can be colour configured and given a label.

• Contour Graph. This graph type can only be used to plot single two-dimensional
data sets. Both the number of contours and colours are configurable.

• Density Graph. This graph type can only be used to plot single two-dimensional data
sets. In this plot, the magnitude of the data is reflected by the colour intensity of each
pixel.

• 3D Surface Graph. This graph type can only be used to plot single two-dimensional
data sets, where the z-plane reflects the magnitude of the values.

The configuration of each graph type is discussed further in section 6.3.8

6.3.3 Opening the Plot Document

To start using the extended data extraction tools, select the New Plot Window menu item
from the Plot menu in any EnviView window (as shown in Figure 6.9).
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Figure 6.9  Starting a new plot window

The Plot menu contains several sets of preconfigured or saved graphs, and a set of
graph templates. The description of the preconfigured graphs follows this section. Once a
preconfigured graph or a graph template is selected, a plot window pops up displaying
the selected graph type. If a further preconfigured graph or graph template is selected, it
too is added to the plot window. The user can easily switch between graphs using the
tabs at the bottom of the plot window.

6.3.3.1 The Graph Panel

Figure 6.10 shows the plot window displaying the two-dimensional line graph template.

Figure 6.10  Plot window
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At the bottom of the plot window is a tabbed panel, which can be used to switch between
graphs. Each tab contains a graph and a Graph Panel, which provides the user with the
following options:

• The "+" button allows the user to increment through the data and choose the next
record or the next field as set on the Variable Extraction Panel (see section 6.3.6.1).

• The "-" button allows the user to decrement through the data and choose the
previous record or field as set on the Variable Extraction Panel (see section 6.3.6.1).

• The Configure button brings up a dialog box which allows the user to change graph
properties such as the title and axis labels etc. (see next section).

• The Add/Set Data button brings up the Add/Set Data Dialog which can be used to set
the data for the selected graph (see section 6.3.4).

• The Modify Data button brings up the Modify Data Dialog described in section 6.3.5.
Note that this button is only enabled if data has already been added to the graph.

6.3.3.2 Graph Configuration

Clicking on the Configure button brings up a dialog box similar to the one shown in Figure
6.11 below.

Figure 6.11  Graph configuration dialog box

The dialog box provides the user with the following options:

• The name text field allows the user to change the name/title of the graph.

• The X and Y axis title fields allow the axes labels to be changed.
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• The X and Y axis maximum and minimum fields display the current X and Y ranges.
Note that the maximum and minimum values are only enabled if their variation is not
restricted by the graph type.

• Configurable options specific to certain graph types (see section 6.3.8) are displayed
at the bottom of the dialog box.

• The OK button confirms the changes and closes the dialog box.

• The Cancel button ignores any changes and closes the dialog box.

6.3.4 The Add Data Dialog

As shown in Figure 6.12 below, the Add Data dialog provides the user with the following
options:

• All graph data sets are given a default name by which they can be identified. The
name text field allows the user to rename the graph data set to something more
appropriate or preferential.

• Variable selectors for each axis or plane allow the user to select from a list of
preconfigured variables.

• The Get New Variable button brings up the Add Variable Dialog (see section 6.3.6)
and allows the user to choose new variables not included in the preconfigured
variables list.

• Configurable options specific to certain graph types (see section 6.3.8) are displayed
at the bottom of the dialog box.

• The OK button confirms the changes and closes the dialog.

• The Cancel button ignores the changes and closes the dialog.

Figure 6.12  Add Data Dialog
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6.3.5 The Modify Graph Data Dialog

The Modify Data button, which causes the Modify Graph Data dialog to be displayed, is
only enabled if data has already been added to the graph using the Add/Set Data option
discussed above. Hence, this option only allows users to change graph data type
variables that already exist.

Figure 6.13  Modify Graph Data Dialog

The ModifyGraph Data dialog, shown in

Figure 6.13 above, provides the user with the following options:

• A list of all the available graph data type variables is displayed on the left hand side
of the dialog box. Variables already displayed in the graph are marked with a tick.
The variables can be removed from the graph by clicking on them until their tick is
removed. To change the configuration of any of the variables on the list, simply click
on them until they become highlighted. Then make the necessary changes using the
available options discussed below.

• All graph data sets are given a default name by which they can be identified. The
name text field allows the user to rename the graph data set to something more
appropriate or preferential.
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• Variable selectors for each axis or plane allow the user to select from a list of
preconfigured variables. Note the difference between a variable and graph type
variable as discussed in section 6.3.1.

• The Get New Variable button brings up the Add Variable Dialog (see section 6.3.6)
and allows the user to choose new variables not included in the preconfigured
variables list.

• Configurable options specific to certain graph types (see section 6.3.8) are displayed
at the bottom of the dialog box.

• The Delete button deletes the selected item from the list of available graph data
variables.

• The Update button allows changes to be confirmed before moving on to make further
changes to other graph data sets on the graph variable list.

• The OK button confirms the changes and closes the dialog.

• The Cancel button ignores the changes and closes the dialog.

6.3.6 The Add Variable Dialog

Figure 6.14  Add Variable Dialog
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The Add Variable dialog, shown in

Figure 6.14 above, provides the user with the following options:

• A list of preconfigured variables, displayed on the left, allows the user to select
between the variables. Upon selecting a particular variable on the list, a View Data
panel is brought up displaying the data associated with the variable selected.

• The tabbed panel provides the user with three options:

- A View Data option, which as discussed above, simply displays the data
associated with a selected variable.

- An Extract Data option, which is referred to as the Pds Variable Extraction Panel, is
discussed further in the next section

- A Combine Data option, which allows the user to transform or combine two or more
variables is described in section 6.3.6.2.
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6.3.6.1 Pds Variable Extraction Panel

Figure 6.15  Pds Variable Extraction Panel

The Pds Variable Extraction Panel, shown in Figure 6.15 above, provides the user with
the following options:

• The element selection tree, displayed on the left of the panel, shows all Envisat
product files that have been opened by the running EnviView session. The selection
of an element on the tree results in the selected element being expanded to display
its contents of child elements. Hence, the selection of a product results in it
expanding to show its list of data set records (DSDs). Similarly, the selection of a
DSD results in it expanding to showing its list of fields. In the case of complex fields,
they can be further expanded to show a list of their sub fields. When an extractable
element on the tree is selected, hence, a field or a sub field, the Add button at the
bottom becomes enabled.

• The name text field is by default set to have the same name as the selected field on
the element selection tree. The user is able to change this name, but it must be noted
that each variable name must be unique.

• The First Record and Record Count options are both user configurable and by default
are set to 1. As its name suggests, the First Record option marks the record at which
the data extraction should start. The Record Count option specifies the number of
records to be extracted starting at the First Record. Below the two user configurable
options is a label showing the total number of records available. The Adjustable
Dimension check box allows the user to activate the "+" and "-" buttons discussed in
section 6.3.3.1.

• The First Field and Field Count options are both user configurable and by default are
set to 1. As its name suggests, the First Field option marks the field at which the data
extraction should start. The Field Count option specifies the number of fields to be
extracted starting at the First Field. Below the two user configurable options is a label
showing the total number of fields available. The Adjustable Dimension check box
allows the user to activate the "+" and "-" buttons discussed in section 6.3.3.1. Note
that these options are only enabled if the element selected on the element selection
tree is a field or a sub field.

• The First SubField and SubField Count options are both user configurable and by
default are set to 1. As its name suggests, the First SubField option marks the sub
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field at which the data extraction should start. The SubField Count option specifies
the number of sub fields to be extracted starting at the First SubField. Below the two
user configurable options is a label showing the total number of sub fields available.
The Adjustable Dimension check box allows the user to activate the "+" and "-"
buttons discussed in section 6.3.3.1. Note that these options are only enabled if the
element selected on the element selection tree is a field or a sub field.

• The Add as1D button extracts the data selected into a one-dimensional array.  Note
that this button is only enabled if the data selected meet the extraction criteria.

• The Add as2D button extracts the data selected into a two-dimensional array. Note
that this button is only enabled if the data selected meet the extraction criteria.

6.3.6.2 The Combine Data Panel

Figure 6.16 Combine Data Panel
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The Combine Data Panel, shown in

Figure 6.16 above, allows the user to transform or combine two or more variables using
the following options:

• The name text field allows the user to label their expression, thus allowing the
modified or combined data to be identified.

• The expression text field allows the user to transform or combine variables using the
normal mathematical symbols and brackets for ordering operations. Note that all
variable names, mathematical symbols and brackets must be separated by spaces.

6.3.7 How to plot a and extract the data for a graph

• Start EnviView and open a product file.

• Go to the Plot menu and select the graph type that you wish to plot e.g. the 2D Line
Graph.

• If the 2D line graph option is selected, the Plot Window appears with a blank 2D line
graph. Similarly, if other graph types are selected, the Plot Window appears with their
blank equivalent.

• Click on the Add/Set Data button to bring up the Add/Set Data dialog box.

• On the Add/Set Data dialog, click on the Add New Variable button to bring up the
Variable Creation dialog.
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• On the Pds Variable Extraction Panel, click on the element selection tree to select the
fields/sub fields of interest. Then click on the Add as1D button to extracts the
selected data into a 1D array. Finally, click on the Close button to close the Variable
Creation dialog.

• Now on the Add/Set Data dialog, set the X and Y values. For example use the X
Variable selector to set the X value to index and the Y Variable selector to set the Y
value to the variable that you have just extracted.

• Click on the OK button and the data should now appear plotted on the graph.

• You can now label the X and Y-axes and change the graph title by clicking on the
Configure button to bring up the Configure Graph dialog box.

• Click on the Modify Data Button . The Modify Data Dialog should appear. Change the
colour of the line by clicking on the Line Colour button.

• Similarly, other configurable options may be changed by clicking on the Modify Data
button to bring up the Modify Data dialog box.

6.3.8 Configuring each graph type

Each graph type is different and therefore has a slightly different configuration. The graph
specific configurations for all the different graph types are described in the sub sections
below.

6.3.8.1 The 2D line graph

- The 2D line graph has the ability to zoom into a particular area. By holding the Shift
Key and pressing the left mouse button an area can be selected to zoom. To zoom out
simply hold down the Shift Key and clicking on the left mouse button.

- In the Graph Configuration dialog there is the Marker Line Configuration Panel. Using
this configuration panel, a marker line, which is simply a straight line parallel to the X or
Y axes, can be set to guide the eye or mark a certain level. The Marker Line
Configuration Panel, shown in Figure 6.11, has to following configurable options:

• The Use check box allows the user to activate or deactivate the marker line.

• The name text field allows the marker line to be labelled.

• The Orientation Selector can be set to either horizontal or vertical. Hence,
displaying a marker line either parallel to the x-axis or the y-axis.

• The Position option allows the marker line to be offset from the origin.

• The Colour option allows a preferential colour to be selected for the marker line.
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In the Modify Graph Data dialog, shown in

- Figure 6.13, the configurable options specific to the 2D Line Graph include:

• The Interpolation type selector can be set to either linear or spline. If set to linear,
data points are connected with straight lines. If set to spline, data points are
connected with curved lines.

• The Line Colour button allows a preferential line colour to be set.

• The Fill Colour check box can be used to activate or deactivate the fill colour
option.

• The Fill Colour button allows a preferential background colour to be selected.

6.3.8.2 The 3D line graph

- The 3D line Graph allows the plot to be rotated. This can be achieved by clicking and
holding the left mouse button and moving the mouse to the angle of rotation required.
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Figure 6.17  Specific panel for 3D Line graph data

In the Modify Graph Data dialog, shown in

- Figure 6.17 above, the configurable options specific to the 3D Line Graph include:

• The Line Colour button allows a preferential line colour to be set.

• The Fill Colour check box can be used to activate or deactivate the fill colour
option.

• The Fill Colour button allows a preferential background colour to be selected.

6.3.8.3 The Pie Chart

- The Pie Chart has no specific configurable options.

6.3.8.4 The Bar Chart

- The Bar Chart has no specific configurable options.
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6.3.8.5 The Contour Graph

Figure 6.18  Specific panel for contour graph data

In the Modify Graph Data dialog, shown in

- Figure 6.18 above, the configurable options specific to the Contour Graph include:

• The Contour number option allows the number of contours to be set.

• The Palette number option allows the colour palettes to be set.
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• The Soften 3 x 3 check box can be selected to interpolate the data using a 3 by 3
matrix.

• The Soften 5 x 5 check box can be selected to interpolate the data using a 5 by 5
matrix.

6.3.8.6 The Density Graph

- The Bar Chart has no specific configurable options.

6.3.8.7 The 3D Surface Graph

- The Bar Chart has no specific configurable options.
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6.4 Saving Graph configurations

To save a graph which has been created in the Plot Window. Make sure that the graph to
be saved is top graph in the Plot Window. From the Plot Menu in the Plot Window select
the 'Add to Plots' menu item.

A Save Dialog box appears asking for a menu item name to be inputted. This name is the
name of the menu item on the Plot menu which the graph will be placed under. If the
name is left blank the graph will appear directly under the Plot menu. This allows the user
to group together graphs or a similar nature.

If this graph has been saved before the current group menu will be displayed in the dialog
box.

The text on the menu item, which represents the graph, will be the title of the graph.

Pressing the 'Save' button will save the graph, and the dialog will close.

If you are saving a graph which has been saved before, when the 'Save' button is
pressed a second dialog box appears asking whether to overwrite the existing graph or
save it as a new graph.

Once the graph has been saved it will appear on the Plot menus. On the Plot menu for
the Plot Window, there is a sub menu for each open product and the graph will appear
there. On the Product Window, just the graphs for that product are displayed there.

N.B. graphs that have data on from more than one product can not be saved.

6.4.1 Loading a Saved Graph

To load a saved graph, make sure that the product that contains the data for the graph is
open.

To Load from the Product Window

From the Plot menu in the Product Window select the graph to be loaded. If the Plot
Window is not open, it will be opened and the loaded graph displayed. If the plot Window
is open, it will be brought to the front and the graph displayed.

To Load from the Plot Window

From the Plot Menu, select the product to which the graph belongs. A Sub menu will be
displayed containing all the saved graphs for this product. Select the graph to be loaded
and the graph will be displayed.

6.4.2 Deleting a Saved Graph

To delete a saved graph, open the graph and make sure this is the top graph in the Plot
Window. Go to the Plot window and select 'Remove From Plots'. A confirmation dialog
box is displayed. Press Yes to delete the graph.

Only user saved graphs can be deleted. No graphs provided with the EnviView
installation may be deleted.
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7. VIEWING ENVISAT IMAGE DATA

Envisat has three imaging instruments, AATSR, ASAR and MERIS, each producing a
number of different data products containing image data sets, i.e. containing arrays of
image pixel scan lines. If an open product contains an image data set, the New Image
View option from the View menu is available (otherwise it is greyed out). Select this menu
item to open a new image view.

Figure 7.1 Starting a new image view

By default, the first image measurement data set is displayed in the image viewer. Select
the data set required from the data set pop up menu as shown in Figure 7.2.

Note that the AATSR level 2 averaged surface temperature product (AST_AR_2P) does
not contain image scan lines, and hence can not be displayed in the image viewer. It
provides a set of geolocated sample points, which may be displayed using the 2-D map
view (see Chapter 9 for details).

Figure 7.2 Image Viewer Window
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7.1 The Image Viewer

An Image Viewer contains a sub-region of the image data set at full resolution. On the
right hand side a thumbnail overview of the entire image can be seen. The overview
image is built up automatically beginning as soon as the data set as been selected.

For best performance, only use files copied to ones local disc. Accessing image files from
a CD-ROM or over the network results in a significantly impaired user experience.

The Image Data Set View consists of the following elements

• Image Viewer at the centre

• Image Overview at the right

• Initially blank, the overview automatically builds up completely every time a new
data set is loaded. Changes to the colour intensity using the colour bar are
shown on the overview as well as the main image.

• Image View Location - a black and white square representing the position of the
Image Viewer window in the entire image.

• Image Viewer Co-ordinates - at the top left and bottom right of the Image Viewer

• The pixel co-ordinates of the top-left and bottom right corner are displayed

• The approximate geographic co-ordinates of the top-left and bottom right pixels
are displayed, If a geographic tie point data set is available in the product.

Figure 7.3 Image pixel co-ordinate system

• The image viewer magnification menu. This has several options, the meanings of
which are:-

• 100% - one screen pixel per image pixel (default).

• 200% - four screen pixels per one image pixel.

• 400% - sixteen screen pixels for one image pixel.
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• A colour bar and scale to the left hand side. This has two arrows on the left, that can
be moved to adjust the image contrast. On the right of the colour bar is a numbered
range, which can be used to adjust the range of pixel values mapped to pixel
intensity.

• A compass above the colour bar shows the direction of North with respect to the
image display.

• A rotation toggle button, allowing the image to be rotated by 180º. By default,
EnviView rotates an image so that North is always displayed at the top when an
image is opened. The button is useful for rotating images that span the North or
South pole. Note only the central image view is rotated, the overview remains in
product scan line order.

• A data set selector pop up menu allows easy selection of another measurement data
set, within the product, to be displayed.

• A quantity selector pop up menu allows one of multiple quantities that may be
available in an image data set.

• An overlay button, allowing a second data set or quantity to be overlaid on top of the
first. The colour channel of the overlay image may be either Red, Green or Blue,
selected through three small buttons below the overlay data set selector.

• A working indicator “barber pole” is displayed below the main image every time a new
image area is selected whilst loading of the image takes place. Once the loading and
display is completed, the working indicator disappears.

• Specific pixel information and statistics are displayed in a popup-window.

7.2 Moving around the Image

The Image View can be moved around the image using the scrollbars, the keyboard
cursor keys or the mouse. To use the keyboard, ensure that either the Image View or
Image Overview has the input focus. A simple click of the mouse in either of these views
will restore the focus if it has been lost to another component. Movement with either the
mouse or the keyboard is very responsive if the image pixels needed to fill the screen
have already been loaded. Otherwise, a small delay is incurred as the new pixels are
read from the data set. In order to keep the memory requirements to a minimum, pixel
data will be discarded when moving to other areas of the image.

There are various ways to move the Image and control the distance moved to the
required precision using the keyboard.

• The cursor keys + CONTROL move the Image View by 1 pixel.

Ctrl

1 pixel
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• The cursor keys alone move the Image View by 10 pixels.

 

10 pixels

  

• The cursor keys + CONTROL + SHIFT move the Image View by 20 pixels.

Ctrl Shift

20 pixels

• The cursor keys + SHIFT move the Image View by 200 pixels.

Shift

200 pixels

The mouse can also be used to move the Image View by clicking in the square marking
the position in the Image overview. The mouse button is held down and the square
dragged to the new location, see Figure 7.2. After a short delay as the image data is
loaded and the Image window is updated.

Figure 7.4  Overview Window
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Horizontal and vertical scrollbars indicate the position of the image view in the larger
image area. In addition to the overview and keyboard, the scrollbars may also be used to
navigate around the image area.

While the image data is being read from disk, scaled and prepared for display, a barber
pole ‘busy’ indicator is displayed at the bottom right hand corner of the window.

7.3 The Colour Bar

Images are displayed on screen using a 256 colour look-up table, from black to white (an
exception are images stored in RGB format). The Colour Bar indicates and controls the
mapping from pixel values to intensity (or shades) on screen.

A pixel value axis determines the range of pixel values that are mapped to the colour
table. Markers on the colour bar allow the colour look up-table to be adjusted.

By manipulating the colour bar in the Image Data Set Viewer, the contrast and colour
range may be adjusted to a certain degree.

The colour bar consists of the following elements (see Figure 7.5)

• The pixel value axis, on the right.
This determines the range of the pixel values that correspond to the colour scale.

• Two adjustable colour markers.
The colours of intermediate pixel values are interpolated between markers.

• The pixel value at each marker on the left.

• A button to reset the default marker positions and axis range.

Clicking on a marker and dragging the mouse up or down moves the colour marker to
higher or lower pixel values. Releasing the mouse button updates the colour look-up
table, and the image changes immediately.

Clicking on the right of the colour bar brings up a colour scale axis dialog. This allows one
to modify the range of pixel values that are mapped onto the colour scale. Changes to the
colour scale result in a short pause, as the new image colours are recomputed for the
new data range.

The Defaults button returns the markers to their default positions. A triple click on the
colour bar itself will also reset the defaults.

NOTE : MERIS and AATSR browse images contain RGB pixel data, so no colour bar is
provided.
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Figure 7.5  Colour Bar

7.4 Magnifying the image display (zoom)

A popup menu at the top right hand corner of the central image allows the display to be
magnified by 2x or 4x (200 % or 400 %). Coordinates are adjusted accordingly.

Some high resolution images benefit from a zoom-out. By default EnviView does not
provide zoom out options, as this requires significant memory and processor
performance to provide an acceptable user experience. Zoom-out may be enabled by
selecting a checkbox in the preference panel EnviView -> ImageView.

7.5 Geographical Co-ordinates

Most image data sets are associated with a geographical tie point data set. A tie point
data set associates an approximation of a geographical co-ordinate  with a given pixel in
the image. EnviView is capable of using this information to estimate the geographical
location of any pixel on the image using linear interpolation.

7.6 Pixel quantities

Many Image data sets contain multiple quantities, using various different methods of pixel
and quantity interleaving. EnviView includes the capability to decode these data set
specific quantities, and apply any quantity scaling and offset that might be required.

The quantity is selected from the quantity popup menu on the right side of the image
viewer. The values given in the popup menu and the colour scale adjust accordingly.
Each quantity has it's own colour scale and units.

7.7 Overlaying Images

Two image quantities, from one or two data sets may be overlaid on top of each other.
This may be useful when comparing image data over the same area measured in
different frequency bands or polarisations. The overlay may also be useful for displaying
a per pixel flag in an associated data set (AATSR and MERIS).

An overlay image may either be blended onto the base image, using a single colour
chanel (red, green or blue), or mixed with the base image, replacing one colour channel.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 69 of 141

When blending, the base image remains grey scale. When mixing, the overlay image
takes one colour channel, and the base image takes the remaining two. For instance, if
the overlay image is displayed in Red, the base image would be displayed as cyan
(Blue+Green).

The colour scale at the left of the image affects only the base image.

7.8 Image Statistics

Clicking on a pixel and keeping the button pressed in the Image Viewer brings up a
popup window detailing the image pixel co-ordinates and approximate geographic
location (if a tie point data set is available) and the image pixel value and units. If an
overlay image is selected, the values of both the base image and overlay image pixels
are provided.

Figure 7.6  Image pixel pop-up window

A large cross for identification marks the pixel. This function is typically used at 200 % or
400% magnification because it is easier to identify individual pixels of interest. Dragging
the mouse selects an area of the image.

Figure 7.7  Selecting an area of an Image

The pixel and geographic co-ordinates (if a tie point data set is available) of the top left
and bottom right corners of the area are updated in the dialog as the mouse is dragged.
Releasing the mouse button produces an Image Selection window, Figure 7.8.
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Figure 7.8  Image Selection window

The selection window is split into three parts

• Area : which repeats the top-left and bottom right pixel location, and geographic co-
ordinates (if a tie point data set is available).

• Statistics : which presents a few simple statistics about the image data in the
selected area :

• Total number of pixels in the area.

• The average pixel value.

• The standard deviation of the pixel data values.

• The maximum pixel value and its location.

• A histogram of the pixels in the selected image area

When a large area is selected, it may take a short time before the computations are
complete. The statistics fields contain a '-' until the computation is complete.

• Export : Save the pixels of the selected area to a file. Available formats include TIFF,
GIF, PPM, Tab separated text and raw pixel values. See section 11.1 for more
information. 

Close the dialog by clicking the window close button in the window frame.
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8. VIEWING WAVE SPECTRA

A wave spectrum viewer displays a false colour polar plot showing level 1B or level 2
ASAR wave spectra data. As the Level 1B data values are complex numbers, having
both real and imaginary parts, various representations of the spectra are possible.

Data is displayed one record at a time. Buttons are provided for selecting a specific
record, or stepping backwards or forward by one record. The evolution of wave
measurements may be evaluated by viewing subsequent spectra as a movie,
automatically stepping through the product , record by record.

To open an ASAR Wave view, select the New ASAR Wave Spectra View, from the View
menu as shown in Figure 8.1. This option is only enabled if an appropriate data product is
open (ASA_WVI_1P, ASA_WVS_1P, ASA_WVW_2P).

Figure 8.1  Starting an ASAR Wave Spectra View

An ASAR Wave Spectrum viewer will open similar to that shown in Figure 8.2.
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8.1 Feature Summary

Figure 8.2 shows an example of an ASAR wave spectrum viewer, displaying a level 1B
cross spectrum. It contains a control area at the top, below which is the graph,
information and identification area. The spectra data itself are displayed on a polar graph
plot in the middle of the image (with the 50(m), 100(m) and 200(m) radii).

Figure 8.2  ASAR Wave Spectra Viewer

The characteristics and features of the ASAR wave data are summarised below, starting
at the top of the window and moving downwards.

• Menu bar and Menus
These are identical to those on other EnviView windows.

• View tabs
These select other open views with a single mouse click.

• Data Set selector
This displays the name of the current wave data set, in the data product, and allows
selection of other wave data data-sets, if available. Nominally there is only one wave
spectra data set in a product.

• Record Selector Controls and indicators.
These consist of

• a Record field, which indicates the currently displayed record number, and allows
a particular record to be accessed directly, by typing its index.

• nudge back and forward buttons allows progress through the data set, one
record at a time

• a record slide control which allows fast access directly to a particular part of the
data set.
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• Movie Controls.
The movie controls are to the right of the record slider. They consist of a play button,
a pause button and a movie speed control.

• Spectrum type selector (level 1B products only).
This allows selection of various views of the spectra data. See section 8.7 for more
details.

• Graph Area
The graph area shows a wave spectrum polar plot. See section 8.8 for more details.
The Orientation axes show information about the along track and cross track
directions (level 1B products) or North and East (level 2 products). The colour scale,
to the right of the polar plot shows how values are converted to colours on the plot.
The scale can also be entered, see section 8.5 for more information about this.

• Identification and Information Area.
This area, at the bottom of the window, shows orientation information (see section
8.8.2), identification information for the data product, data set and record number, the
type of spectrum displayed and the data on which the data was acquired. Also the
magnitude and position of the peak point of the spectra is stated.

8.2 Selecting a data set to view

The data set pop-up menu, towards the top of the window, contains a list of available
data sets for the product. It displays the name of the data set that is currently being
viewed. To select a different data set (if available), click and open the pop-up menu and
select the data set.

8.3 Selecting Records

When an ASAR wave spectrum viewer is opened, data from the first record is displayed
by default. There are various ways of navigating to other records. The controls available
are shown in Figure 8.3.

Figure 8.3  Record Navigation controls

These controls enable one to go;

• directly to a specific record,

• back or forward one record at a time

• and browse through the records.

The details of how to carry out these operations are below;

The Record field at the left indicates which record is currently being displayed. To go
directly to a specific numbered record, select the Record field and type in the record
number. Remember to press enter. EnviView will display data from the record required.
Note the maximum number of records is displayed under the right hand edge of the
record slider.
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To move one record at a time through the data set press the back and forward “nudge”
buttons ( ) located between the Record field and the record slider.

To slide through the data set; use the record slider. Click and drag the slider control to
the approximate position in the data set required.

8.4 Playing a movie

The EnviView ASAR wave spectrum viewer can display one record at a time in the
forward direction, with a controllable interval between each frame, just like a movie. The
controls to do this are shown in Figure 8.4.

Figure 8.4  Movie Controls

To start a movie, drag the record slider to the left to the point at which to start the movie,
then press the play button ( ).

To stop the movie, press the pause button ( ). The movie will stop automatically at the
last record.

The speed control button ( ) activates a menu that enables control of the interval
between frames of the movie of between 1/10 second and 2 second. Shorter intervals
between frames mean that the movie plays faster, and longer frame intervals mean that
the movie will play more slowly. To alter the movie speed, press the speed control button
and select the frame interval from the pop-up menu. The speed can be changed
interactively whilst a movie is running.

8.4.1 Rescaling behaviour

Note that the default settings mean that the plots are rescaled every movie frame. To
make it easier to follow the progression of data through the movie, set the scaling to
manual, and fix the colour scale range to appropriate values. See section 8.5 for details
about how to do this.

8.5 Changing the spectra display

Level 1B spectra can be displayed in a number of different ways, more details can be
found in section 8.7. To change the type of spectra; select the Spectrum type pop-up
menu and choose the type of spectrum to display from the list displayed. The Intensity
spectrum is the default displayed. Resizing the ASAR wave spectrum viewer window
changes the size of the plot on the screen.

The colour scale of the spectrum plot can be modified, to emphasise certain parts of the
field range, if required. Double click on the colour bar (on the right hand side of the
window) to change the mapping of colours to field values (the colour scale). An “Axis
parameter” dialogue box will up similar to that shown in Figure 8.5 .
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Figure 8.5  Changing the Colour scale

If the Auto radio button is checked EnviView will fit the spectrum data to maximise the
use of the colour scale.

Select the Manual radio button to enter a specific range of values for the colour scale.
Then type the lower limit into the From: text field and the upper limit into the To: text
field. Press the Apply button to implement the changes. Any data outside the range
entered will be displayed as red, if it is greater than the upper limit, or white, if it is less
than the lower limit. The manual setting is useful for displaying movies as it prevents the
plot values from being rescaled every frame.

Note; if the Exact check box is left unchecked EnviView may round the axis limit values
entered.

8.6 Getting specific bin information

Detailed information about a specific spectral bin on the image can be obtained simply by
clicking on it. A pop-up panel shows the bin index number, the wavelength and direction
of the bin, and the plotted value. Figure 8.6 shows an example of detailed spectral bin
information by clicking on bin (7,7).

Figure 8.6  Detailed spectral bin information

By clicking and dragging the mouse over the spectra it is possible to interactively see the
detailed information for each bin that the mouse pointer passes over.
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8.7 ASAR Wave Spectra display types & characteristics

The ASAR level 1B wave spectrum data is complex, containing both real and imaginary
parts, as stated in the introduction. EnviView only displays scalar (1 dimensional) values
on the ASAR wave spectrum viewer, which means that it can only display either the real
parts, the imaginary parts or some scalar combination of the real and imaginary parts.

ASAR Level 2 data is not complex, hence there is no need selection provided for different
display types when viewing such a data set. Level 2 data is neither symmetric nor anti-
symmetric, and contains information for the entire 360º spectrum.

8.7.1 Level 1B Spectra symmetries

The level 1B wave spectra are 180° (half turn), rotationally symmetric (real part) or anti-
symmetric (imaginary part), about an axis through the centre of the plot. This means that
the data shown on a complete spectrum (360°) can be redundant i.e. the left hand side of
the plot gives the same information as the right hand side of the plot. In fact, only the first
180 degrees of data are available for both the real and imaginary parts of the spectra.
The second half (180-360 degrees) is synthesised, by EnviView, using the symmetry
properties of the data.

Figure 8.7 and Figure 8.8 show examples of images that are half turn rotationally
symmetric and anti-symmetric. Note, in both cases, that image data is redundant. Given
any half of either image, the other half can be constructed from it (as is the case for wave
spectra real and imaginary spectra).

Figure 8.7: Half turn rotationally symmetric image

Real spectra are half turn rotationally symmetric.

Figure 8.8  Half turn rotationally Anti-symmetric image

Imaginary spectra are half turn rotationally anti-symmetric.
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8.7.2 List of level 1B spectra types

The types of Level 1B spectra display available in the ASAR wave spectrum viewer are
as follows;

• Real Spectrum

Only the real part of the spectrum is plotted. Note that the real spectrum is symmetric
(see Figure 8.7).

• Imaginary Spectrum

Only the imaginary part of the spectrum is plotted. Note that the imaginary spectrum
is anti-symmetric (Figure 8.8)

• Both Spectra

Both half the real and half the imaginary spectra are plotted, with the real on the left
and the imaginary on the right.

• Power Spectrum

In power spectra, the values are computed as:

real2 + imaginary2

NB. If the real and imaginary are out of phase (i.e. real / imaginary < 0) then the
corresponding bin value is set to zero. This helps remove the wave direction
ambiguity from the plot.

• Intensity Spectrum

This is the default plot. In intensity spectra, values are computed as:

÷ (real2 + imaginary2)

NB. If the real and imaginary are out of phase (i.e. real / imaginary < 0) then the
corresponding bin value is set to zero. This helps remove the wave direction
ambiguity from the plot.

• Multiplied Spectrum

In multiplied spectrum, values are computed as:

real * imaginary

NB. If the real and imaginary are out of phase (i.e. real / imaginary < 0) then the
corresponding bin value is set to zero. This helps remove the wave direction
ambiguity from the plot.
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8.8 The ASAR Wave spectra display characteristics

ASAR wave spectra are encoded in a polar grid in the measurement data set. While
visually similar, there are a number of differences in the encoding and storage order that
must be taken account of when reconstituting the spectral values. This section describes
the particular characteristics of Level 1B and Level 2 ASAR spectta data.

8.8.1 Level 1B spectra characteristics

Figure 8.9 shows an example of a Level 1B ASAR wave spectra. The image is a polar
plot of ASAR wave spectrum data placed into discrete bins. Each wave spectra image is
composed of 864 bins arranged in a polar plot.

• Level 1B data is organised in the anti-clockwise direction

• Data is stored in the product in sectors, from the longest to the shortest wavelength.

• The first bin (1,1) is at the centre (from –5° to 5°) of image.

• The last bin of the first sector (1,24) is at the top (from –5° to 5°) of image.

• Each bin has a real and an imaginary value

Figure 8.9  Level 1B ASAR Wave spectra image
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• The spectrum image is divided up into 36 sectors or “spokes”, each 10° wide. Note
that due to the symmetry of the spectra, only data from the first 180° (anti-clockwise)
of the spectra are provided i.e. sectors 1 to 18. The other half of the spectrum display
(sectors 19-36) can be constructed from the first half as the real part of the spectrum
is symmetric and the imaginary part is anti-symmetric.

• Each radial sector or “spoke” contains 24 bins numbered from 1, at the centre of the
spectra display to 24 at the outside edge

Each bin is colour coded based on the value of the bin data mapped onto a colour scale
shown to the right hand side of the image

8.8.2 Level 1B Spectra Orientation

The direction origin (0°) is at the top of the Level 1B spectrum, and the angle increases
anti-clockwise, reaching 180° at the bottom of the display continuing back to 360°. The
satellite heading (the along track direction) is at 0°. The orientation axes (see Figure
8.10) show the orientation of the plot.

Figure 8.10  Orientation Information

The arrow, labelled “Azimuth”, shows the along track satellite direction which is always
parallel to the 0° direction of the spectra image. The arrow, labelled “Range”, shows the
satellite cross track direction. This is always orthogonal (i.e. at right angles to) the
Azimuth direction.

8.8.3 Level 2 spectra characteristics

Figure 8.11 shows an example of a Level 2 ASAR wave spectra. The image is a polar
plot of ASAR wave spectrum data placed into discrete bins. Each wave spectra image is
composed of 864 bins arranged in a polar plot.

• Level 2 data is organised in the clockwise direction

• Data is stored in the product in sectors, from the longest to the shortest wavelength.

• The first bin (1,1) is at the centre (from –5° to 5°) of image.

• The last bin of the first sector (1,24) is at the top (from –5° to 5°) of image.

• The spectrum image is divided up into 36 sectors or “spokes”, each 10° wide. Unlike
the level 1B product, all sectors for the full 360° (clockwise) of the spectra are
provided i.e. sectors 1 to 36.

• Each radial sector or “spoke” contains 24 bins numbered from 1, at the centre of the
spectra display to 24 at the outside edge

• Each bin has a single real value
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Figure 8.11  Level 2 ASAR Ocean spectra image

Each bin is colour coded based on the value of the bin data mapped onto a colour scale
shown to the right hand side of the image

8.8.4 Level 2 Spectra Orientation

The direction origin (0°) is at the top of spectrum image and angle increases clockwise,
reaching 180° at the bottom of the display continuing back to 360°. For Level 2 data,
North is at 0° and East at 90°  The orientation axes indicate the orientation of the image.
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9. VIEWING 2-D MAP DATA

A 2-D map view is similar to a simple graph view, except the x-axis is longitude, the y-
axis is latitude and a world-map (coastline) is drawn in the background. Points may be
plotted on the graph, and the colour of the point may be controlled by a third parameter.
Only fields from data sets that have geographical “tie point” information may be plotted in
the view.

It is possible to zoom in to view particular regions and select the field values to plot from
a list of those available.

9.1 Quick Start

Open a level 1b or level 2 data product. The File View lists the available data sets. From
the View menu, select the New 2-D Map View menu item (as shown in Figure 9.1).

Figure 9.1  Starting a 2D Map view

A 2-D map viewer will open similar to that shown in Figure 9.2 containing a map of the
whole world. The first data set containing geographical data will be automatically
selected, and a range of data set records will be extracted and plotted immediately.

The latitude/longitude points will be initially all in red. A third field may be selected to vary
the colour of each of the points on the graph.  This may be performed using the Value
Field pop-up menu. More details about this process are available further on in this
Chapter.

9.1.1 Differences between an image view and a 2-D map view

EnviView Image View (see Chapter 7) and 2-D map View look somewhat similar as they
both display two-dimensional false colour images of Envisat data associated with
geographical (latitude and longitude) position. However there are important differences
between them that are described below.

An EnviView Image is a “flat” two-dimensional pixel array that is simply mapped onto the
two-dimensional pixel array of the computer screen. Linear scaling is the only additional
type of transformation that EnviView carries out on Image data. Latitude and longitude
data is associated with the pixels of an Image by EnviView however this information is
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not intrinsic to the image data itself. Zooming and scaling of Images is based on pixels
(e.g. screen pixels/image pixel).

Every point displayed on the 2-D map view has an associated geographical tie point
reported in the product file. The map data (field values) are plotted, using false colours,
onto the computer screen using a rectangular projection oriented with north as the top of
the image. Zooming and scaling of a 2-D map view image is based on latitude and
longitude (e.g. height and width of the image are scaled as angle).

The measurement data in the AATSR AST_NR__2P image product can be visualised
using the Image View. On the other hand the AATSR AST_AR__2P and AST_MET_2P
products can be visualised using the 2-D map viewer (Figure 9.3).

9.2 Feature Summary

This section briefly states the features available for viewing 2-D maps. More details are
available below.

Figure 9.2  2-D Map Viewer

Figure 9.2 shows a 2-D map Viewer window that has just been opened. The features
available are;

• Menu bar and menus.
These are identical to those on other EnviView views.
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• View tabs
These select other open views with a single mouse click

• Data set selector
This displays the name of the current data set and allows selection of other data sets
in the data product that are associated with geographical tie point data.

• Record selector and navigation features.
The Record field shows the record number of the first record displayed. The
records/plot field shows how many records are currently displayed on the plot. The
nudge buttons and slider enable navigation through records.

• Value Field
This is the field that may have its values plotted as false colours on the data area.

• Latitude and longitude field (tie point selectors)
These are the fields used to define the geographical co-ordinates that are used to
plot the data points.

• Data area
This shows a map, with land areas as grey and the sea as white, over which are
plotted the field values (as false colours). The colour to value mapping is shown on
the colour bar to the right of the map. The x and Y axes show the latitude and
longitude scales that can be altered. Figure 9.3 shows an example of these features.

Figure 9.3  Geolocated AATSR Image Data

• Information and identification area.
At the bottom of the window, the data set and file names are shown together with the
range of records displayed. Finally the X, Y (grid co-ordinates) and field value (y*)
names, units and field indexes are specified.

9.3 How EnviView selects Map View Data

Only data sets containing geographical tie point data can be displayed by the 2-D map
viewer. EnviView handles this selection automatically; only listing data sets that are
available for map viewing. The algorithm EnviView uses to decide looks through the data
sets for a field with a Geocoordinate data type, and a name containing "lat", or "lon". If
EnviView finds matching fields, it makes it available for display using the 2-D map viewer.
It then displays the first matching fields it finds.
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9.4 Selecting a data set to view

The Data Set pop-up menu, towards the top of the window, contains a list of available
data sets for the product.

Figure 9.4  Selecting the data set

To select a different data set (if one is available) click and open the pop-up menu and
select the data required.

9.5 Selecting records to view

When a 2-D map view opens it displays the selected field value of every record in the
data set. This means that the record navigation features, the nudge buttons and slider,
are initially not available.

To display a subset of the records, first decrease the number of records per plot. Do this
by selecting the Records/Plot and entering the number of records to be displayed. This
number must be less than the initial value in the field (which is the maximum value).
Make sure Enter is pressed after entering the value.

The nudge buttons (to go back and forward one record at a time) and the record slider
will now be available. Figure 9.5 shows an example with 10 records displayed per plot.
The nudge buttons move one record at a time through the data set and the slider can be
used to move many records at a time.

Figure 9.5  Record navigation & field selector features

Note that the false colour to field value mapping is rescaled, every time the record
selection is changed, to use the full colour range with particular range of field values for
the selected records. This means that points on the map may change colour when the
record selection is altered although they keep the same numerical field value. Use a
manual axis scale to fix the range between plots (click on the colour bar to select the axis
range).

9.6 Choosing a value to plot

The field selected in the Value Field, below the record slider, controls the colour of the
each point. This pop-up menu contains a list of all the field values available to be
displayed. To select a different field to plot, select the Value Field pop-up menu and
choose a different field from the list.

EnviView automatically selects the first latitude and longitude fields it finds in a data set.
Normally, there should be no need to alter the selection.
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9.7 Changing the scale of the map

A map of the whole world is displayed by default (see Figure 9.2). Generally, a smaller
area but in more detail will be used, usually because the data area covers only a small
region of the globe. The ways to do this are;

• Click and drag over the area to view in more detail

• Explicitly set the limits of the latitude and longitude axes

• Let EnviView maximise the view of the data area.

To select an area, move the pointer to the top left corner of the area to be viewed in more
detail. Click and drag towards the bottom right as shown in Figure 9.6.

Figure 9.6  Drag selecting on a 2-D map area

Do not drag select in any other direction to select an area. This will reset the map, i.e.
display a map of the whole world.

The X and or Y scales (latitude and longitude limits) can be set to specific values. e.g. for
the X –axis, double click the X-axis on of the display.
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Figure 9.7  X-axis scaling

An “Axis Parameters” dialogue appears similar to that shown in Figure 9.7. Select the
Manual radio button and enter the desired limits for the longitude scale in the From: and
To: fields. Then press the Apply button to see the changes. If the Exact check box is not
crossed, EnviView may round the values entered.

Exactly the same process is used to adjust the longitude scale. The only difference being
that the Y-axis must be double clicked to activate its “Axis parameters” dialogue box.

To let EnviView maximise the area of the plotted data, double click the X-axis to activate
the Axis parameters dialogue box and select the Auto radio button. Apply and close the
dialogue box. Then do the same for the Y-axis. EnviView will maximise the area
displaying the plotted data for the set of records chosen.

To reset the map, i.e. return to the world view; click and drag, on the map area in any
direction except towards the bottom right.
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10. THE ARRAY MOVIE VIEWER

The array movie viewer shows an animated display of one-dimensional array data sets,
with each subsequent frame of the movie advancing one record through the data set.
Each line on the movie display corresponds to a set of field array values of a record.
Several records can be displayed at a time to help show the progression of the data, with
the records stacked one on top of another.

It has been designed to display Radar Altimeter waveforms, but may be used to display a
sequence of records for any fixed length array field.

To start an array movie, select the New Array Movie View option from the View menu,
(Note: the data set must be an array, with certain characteristics, to be viewable as an
array movie. See section 10.1, for more information). An array movie viewer will open
similar to that shown in Figure 10.1. To start playing the array movie press the play
button ( ) towards the top right of the window.

Figure 10.1  Array Movie Viewer

The array viewer window features are briefly summarised in the list below. More detailed
information about array movie controls and features follows after the summary. Starting
at the top of the window, referring to Figure 10.1, the features are;

• Menu bar and menus.
These are identical to those in other EnviView windows.

• View tabs.
Other open views can be selected with a single mouse click.
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• Data Set selector
This displays the name of the current data set and allows selection of  other data sets
within the data product that can be displayed as array movies.

• Record Number.
The field shows the lowest record number of the displayed records.

• Record navigation. These consist of

• nudge buttons to move 1 record at a time through the movie,

• a record slider control which also displays the number of records in the data set,

• movie controls consisting of

• a play button to start the movie,

• a pause button to stop the movie ,

• and a speed control button ( ) which controls the time interval between movie
frames.

• Field selector

To choose which array field in the record to plot.

• Number of records (lines) per plot and how they are displayed
The overlap pop-up selector closes up the space between the plots and the order
button changes the display order of the records.

• Data area
This shows the field name and (Y) axis scale, a set of plotted lines each of which
corresponds to the field array values of a record to the right of which are the record
numbers. Below the plots is the array index (X) axis.

• Identification and statistics area.
At the bottom of the display the range of records displayed is stated together with the
X and Y-axis data names. The data set and file (corresponding to the data product)
identifiers are also displayed.

10.1 Rules for viewing Arrays

Only certain fields from a data set record can be viewed as an array movie. EnviView
handles this automatically, only allowing valid fields to be selected. This section explains
the rules that EnviView uses to decide whether a field is valid for the array movie viewer.
These rules are as follows;

• The data set must contain 10 or more records.

• The records must contain at least one field that is an array field.

• Only one-dimensional array fields are viewable.

• Each viewable array field must contain 5 or more elements.

The easiest way to check these characteristics of a data set is to open an HTML view of it
and then check the record and field properties.
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10.2 Array Movie Features

This section explains in more detail, how to use specific features of the Array Movie view.

10.2.1 Selecting a Data set and starting an Array Movie View

To start an array movie;

• Select the New Array Movie View from the View menu,
(Note: the data set must be an array, with certain characteristics, to be viewable as
an array movie. See section 10.1 for more information).
An array movie view will open similar to that shown in Figure 10.1.

• Select the data set to view using the Data Set pop up menu below the tab view
selectors.

• To start playing the array movie press the play button ( ) towards the top right of
the window.

10.2.2 Selecting the fields & records to be viewed

The record slider control can be used to move to the approximate position in the data set.
If the data set contains a large number of records use the nudge backward and forward
buttons to move to the exact record number required once in approximately the correct
location. The record number field, to the left of the nudge buttons, shows the exact record
number. Note that this field is not editable and the desired record number cannot be
typed into this field.

To select the field array to be plotted, use the pop-up field menu on the left-hand side of
the Array movie viewer, just below the record field. This pop up displays all the fields, of
the data set records, that can be displayed as array movies.

10.2.3 Changing the speed of a Movie

When the array movie window opens, the movie is stopped at the first record. The movie
can be forwards at varying speeds, stopped, or manually moved backwards and forwards
one or more frames at a time.

• Press the play button ( ) to start the movie.

• To change the speed of the movie, vary the time interval between frames using the
speed control button ( ). This can be done before or whilst the movie is playing.
Press the speed control button to bring up a menu of time intervals between movie
frames and select the interval required. Smaller time intervals (1/10 sec minimum)
give faster play speeds whereas longer intervals (2 seconds maximum) give slower
speeds

• Stop the movie by pressing the pause button ( ). The movie will stop automatically
when it reaches the last record.

• Single record step; Stop the movie and use the nudge backward and forward buttons
( ) to move through the movie a single record at a time.

• Moving to a different part of the movie can be done whilst the movie is playing. Drag
the slider control to the part of the data set to view and the movie will play forwards
from this point if it was already playing. If the movie was stopped press the play
button.
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10.2.4 Changing the look of the data displayed

The number of graphs plotted and their look can be controlled.

• The number of graphs/records displayed on the movie viewer can by varied between
1 and 50. Enter the value required into the records/plot field and press Enter. Note
that the default value is 6 records per plot.

• The spacing between graphs can be varied using the overlap feature. This enables
the plot areas of each line to overlap by up to 50% thus compressing the amount of
screen space needed to display the data. Select the amount of overlap by clicking on
the Overlap pop-up menu and selecting either 0% (no overlap), 25% or 50%.
Resizing the EnviView array movie viewer window changes the spacing and size of
graphs plotted as the data area, containing the plots, expands or shrinks. To increase
the size of the plots, expand the window (the details of this vary according to the user
interface being used). Conversely shrink the window to make the plots smaller

The scale of graphs can be varied. Both the X axis (array indexes) and the Y axis (field
values) scales be varied independently. To alter the X-axis scale, double click on the X-
axis. A dialogue box appears as shown in Figure 10.2.

Figure 10.2  X-axis parameters

The X-axis scale is set to Auto by default. When Auto range is set the array movie viewer
chooses the scale to optimally fit all the record field array data onto the display. However,
to concentrate on a certain part of the array click the Manual radio button and enter the
start and end array elements into the From: and To: text fields. Click the Apply button to
see the changes. The Exact check box is only available when a Manual range is
selected. This constrains the axes to use exactly the values entered into the From: and
To: fields as the start and end points of the X-axis. If Exact is left unchecked, the axis
range displayed may be larger than the values entered manually as EnviView rounds up
the range.

Note that the Axis parameter dialogue box can be open whilst the movie is running and
the graph scale interactively changed.
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Altering the Y-axis (field values) scale is done in the same way as that for the X-axis
scaling. Double click the Y-axis and a dialogue box will open as shown in Figure 10.3.
The fields, check boxes and button behave in the same way as those of the X-axis
parameters dialogue box.

Figure 10.3  Y-axis parameters

Note that all lines plotted on an array movie viewer window use the same X and Y-axis
scales.

10.2.5 Y axis automatic rescaling behaviour

The default behaviour of the movie viewer, whilst playing an array movie is to rescale the
Y-axis every frame to optimise the fit of the latest record. As all the other lines plotted use
the same scale this usually means that every line on the plot is rescaled every frame.

Figure 10.4 and Figure 10.5 illustrate this effect. In Figure 10.4 the plots are scaled to fit
the plot of record 9, giving a Y-axis range from 0 to 150. Figure 10.5 shows the next
frame. In this case the Y-axis has been automatically rescaled to fit the plot of record 10
giving a Y-axis range of 0 to 600. Note however that the record 9 plot is displayed on a
scale of 0 to 600 meaning that the height of it has shrunk to a quarter of the size it was
displayed as in Figure 10.4.

Figure 10.4  Y-axis scaling, record 9 before rescale
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Figure 10.5  Y-axis scaling, record 9 and 10

Set the Y-axis range to Manual to avoid the plots continually being rescaled. This makes
it easier to follow the progression of the data through the movie. However care must be
taken to choose a y-scale that can meaningfully plot the set of data of interested.
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11. SAVING AND EXPORTING ENVISAT DATA

EnviView provides a number of different facilities for extracting and exporting Envisat
data to other file formats. Many of these methods depend on the type of data being
extracted. A number of command line tools are also provided for converting and
extracting Envisat data, see Chapter 14 for more details.

11.1 Saving a Selected Region of an Image

The pixels of a selected image area can be exported to an image file, tab-separated text
or binary data, from the Image Selection dialog in the Image View, Figure 7.8.  Refer to
Section 7.8 for an explanation of how to select an area of an image.

At the bottom of the Image Selection dialog, in the Export section of the window, choose
an output format in which to save the data, from the pop-up list, see Figure 11.1. Click on
the Save as button, whereupon a file selection window will open where the location and
name of the specified file can be chosen.

Figure 11.1 The Export selection for image data

Three image formats are available:

• TIFF: A 24-bit image file.

• PPM: A 24-bit Portable Pixel Format common on Unix platforms.

• GIF: An 8-bit image file. GIF only supports up to 256 colours. If the selected area
contains more than 256 different colour values (e.g in RGB browse images), PPM
should be used.

Exporting data as TIFF, PPM or GIF should be used for presentation purposes only. The
pixel values contained in the data set are converted to colour values depending on the
settings of the Image Viewer colour bar.

To export the actual Envisat image data of the selected region, save as either: -

• Tab separated Text: A line of pixels is represented by a line of text, terminated by the
platform specific line terminator. Each pixel value is separated by a tab character.

• Raw Data: Each pixel value is written to the file as an 8-byte IEEE double.

To export an entire image data set, or a subset of scan lines see section 11.2 on
exporting to HDF.

Command line tools for extracting image data are also provided. See PdsPixels and
PdsPixelTrack in Chapter 14 for more details.
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11.2 Exporting  Data in HDF

The NCSA Hierarchical Data Format is supported by most commercial scientific data
visualisation packages, including PV-Wave and IDL, and a library for reading HDF data is
freely available for C, Fortran and Java. HDF is a self-describing format, so once data is
written into an HDF file, it’s content can be automatically determined, without the need for
an external format description. There are two versions of HDF in common use, HDF 4
and HDF 5. EnviView supports only HDF 4 today.

EnviView can be used to export all or part of an Envisat product in PDS format to a new
HDF 4 file. In addition, specific data sets and records can be chosen rather than
exporting the whole file.

A command line tool is also provided for extracting and exporting to HDF format. See
pds2hdf in Chapter 14 for more details.

Appendix B provides information and examples for reading Envisat data exported to HDF
in Research Systems IDL data visualisation package.

NOTE: HDF support requires the addition of a native library compiled for the platform that
EnviView is being executed on. If the library is not available, or EnviView cannot locate it,
the menu options described below are not accessible. Choose About EnviView in the
Help menu to determine whether EnviView can locate the correct library, also refer to the
README file provided with the software distribution for installation instructions.

11.2.1 Organisation of Envisat data in HDF format

EnviView writes Envisat data into HDF files, conforming as closely as possible to the
format used in the ESA PDS products.

The following approach is used to convert Envisat data to HDF format:-

• EnviView uses the NCSA HDF 4.1r3 libraries.

• No data values are lost

• All data values are stored in the original format, with the exception of:

• ASCII records are converted to their binary equivalents

• Time values are written as a 64-bit double precision floating point value, as Julian
days since January the 1st 2000.

• 64-bit integers are converted to 64-bit double precision floating point values. No
support for 64-bit integers is available in HDF 4.

• An HDF Vgroup is created for each data set, named after the DS_NAME found in the
corresponding PDS DSD. Additional groups called MPH and SPH are also created.

• To distinguish Envisat data set Vgroups from any other, they are assigned the HDF
class "PDS Data Set Record".

• Each data set Vgroup contains

• Scalar fields in a Vdata table, with one row for each exported record from the
PDS data set, and named the same as the enclosing Vgroup. i.e. the DS_NAME
found in the corresponding PDS DSD.The table contains

• An integer entry for the original record number

• An entry (column) for each scalar field, the field name coming from the
Envisat format database.
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• An entry for each element of arrays with five or fewer elements. The field
name is appended by the field index in round brackets. e.g. ‘mw(2)’

• An entry for each scalar field of non-repeating structures. The name of the
sub-field is the name of the parent field, followed by a full stop and the name
of the sub-field. e.g. image_parameters.swst_value in the ASAR Main
Processing Parameters data set. Note that Envisat products do not contain
two or more levels of structures.

• Array fields larger than five elements (or with a variable number of elements) are
written to individual HDF SDS objects (Scientific Data Sets).. Each SDS contains
the values for one field. The first dimension of the data set is the Envisat record
offset. e.g. All image pixels from a single ASAR data set are written into one SDS
are written to an SDS. Each SDS is named after the field name in the Envisat
format database (refer to Product Formats in the EnviView Help menu for more
details).

• Variable length array fields are also written to SDSs, however these are sized to
the largest dimensions of the variable length field, over the exported record
range. Unused elements are written as zeros for integer fields, and the special
IEEE NaN value for floating point data. Each SDS is named after the field name
in the Envisat format database (refer to Product Formats in the EnviView Help
menu for more details).

• The dimensions of each variable length array field, for each exported record, is
written into an optional extra VData named “dimensions”. The entry in the
dimensions VData table matches the name of the SDS (derived from the field
name in the Envisat file format database). This Vdata is not written if there are no
variable length arrays in the data set.

11.2.2 Selecting data for export

If a product is selected in the Product View window and the HDF library is correctly
installed, the Export Product As HDF option in the File menu is enabled. This menu item
leads to a dialog that allows the details of the data sub set for export to be specified.

Figure 11.2 The Subset Selection Window
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The HDF subset selection dialog (see Figure 11.2) is split into three sections.

• The top part of the new dialog ,Data Sets, displays the product name and all the data
sets in this product. The data sets are organised into annotated data sets and
measurement data sets but are all treated in exactly the same way. Note that by
default the ADS list is fully expanded, unlike in the Product View. This area is not
editable. Data sets including the MPH and SPH are selected from here.

• The second section, Subset Selection Choices, contains details about the currently
selected data set. It shows the number of records in the data set and, if appropriate,
the size of the data set in bytes. Below these are two checkboxes.

• Export Dataset is selected if this data set is to be exported to HDF

• Export all Records can be used to select all records in a single click.

The fields labelled First Record and Export Count contain the index of the
first record and the number of subsequent records to be exported.

• The lowest section, Export, contains the estimated total size of the exported data
selected, the value of which is updated as data sets are selected and deselected, a
button labelled Export Now, and a button to Close the dialog. Note that the Export
Now button is not enabled until at least one data set has been selected for export.

NOTE: The total export size can only be estimated because the HDF format includes
structural and formatting information in addition to the data itself, resulting in a somewhat
unpredictable overhead. In general, the overhead is of a fixed amount per data set, so
will not vary with the number of records written. Furthermore, the export data size of data
sets with variable length records is given as a rough approximation.

11.2.3 Selecting a Subset of Data for Export

To select a data set for export, click on its name in the Data Sets list. In the Subset
Selection Choices box, the number of records and size of the data set will be displayed
automatically. The checkbox labelled Export Dataset will be enabled but not ticked
(selected). At this point, no other fields can be edited. The size field reports the size of
the raw data that will be exported.

Clicking the Export Dataset checkbox adds a tick next to the data set name in the list, to
indicate that this data set is marked the export. By default, the Export all Records
checkbox is ticked and the fields First Record and the Export Count are filled in with the
values corresponding to the data set contents. The estimated export size in the lower
window is updated accordingly, and the Export Now button is enabled if it was not done
so already.

Other data sets can be added in the same way. As they are added, the Estimated Export
Size field is updated accordingly.

To select a subset of the records for a particular data set, the Export all Records
checkbox can be deselected. The First Record and Record Count fields become editable
and the desired values can be entered. Negative or non-integer entries are rejected. The
record count is also checked so that the value entered is not too large for the data set,
taking into account the First Record value. The Estimated Export Size is updated
accordingly.

To export the selected data , click the Export Now button and enter an output filename
and destination directory using the platform specific save dialog that appears.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 97 of 141

See Figure 11.3 for an example. NOTE :The SPH size is smaller than the format
documentation specifies, as the DSD’s are not exported (they are replaced by the
directory and catalogue information in the HDF file).

Figure 11.3 An Example of Subset Selection

11.2.4 Shortcuts for Exporting the Data to HDF

Rather than explicitly specifying each data set for export, one by one, there are some
shortcuts to select multiple data sets with a single click.

• To select the whole product, select the product name in the Data Sets menu and
then Export Dataset.

• To select all annotated data sets, select the item Annotated Data Sets in the Data
Sets menu and then Export Dataset. Note, that it is not possible to select a first
record and a record count and have this value applied to all data sets when this item
has been chosen. By default all records are exported. It is, however, possible to then
select individual data sets and set the values separately.

• To select all measurement data sets, select the item Measurement Data Sets in the
Data Sets menu and then press Export Dataset. NOTE: it is not possible to select a
first record and a record count and have this value applied to all data sets when the
this item has been chosen. By default all records are exported. It is, however,
possible to then select individual data sets and set the values separately.

TIP: In certain circumstances, it may be quicker to select all data sets or all MDS or ADS
for export, then deselect ones that are not actually required. See Figure 11.4 for an
example.
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Figure 11.4 Example of a Shortcut being used to Export Data

11.3 Creating a Sciamachy Calibrated (Level 1C) Product

This section deals with creating a Sciamachy Level 1C (SCI_NLC_1P) file from EnviView.
A command line tool to create this file is also available, see section 14.9. A description of
the calibration process and the file format is given in accompanying documents. Detailed
file format information is also available in the EnviView File Format window.

11.3.1 Creating a Level 1C file

A Level 1C file is derived from a Sciamachy Level 1B file (SCI_NL__1P). If a level 1B file
is open in EnviView, the File menu item Extract Level 1 C is enabled. Selecting this menu
item opens a Wizard type dialog to guide you through the process of creating a calibrated
file. Arrow buttons at the bottom of the window are for navigation between each of the
wizard panels. The first panel provides some introductory information.

11.3.1.1 Selecting the extraction Criteria

On the second panel there are five tabbed panes for specifying the extraction criteria.
The first criteria type is the Category Filter (Figure 11.5).
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Figure 11.5  Category Filter

Select this filter with the Apply this filter checkbox. Choose one or more Sciamachy
Categories for extraction by clicking on items in the list. Selected items are marked with a
tick icon appearing beside them. As a short cut, buttons are provided for selecting all or
none.

The second criterion is the Cluster filter (Figure 11.6).

Figure 11.6  Cluster Filter

Select this filter with the Apply this filter checkbox. Choose one or more measurement
clusters for extraction by clicking on items in the list. Selected items are marked with a
tick icon appearing beside them. As a short cut, buttons are provided for selecting all or
none. The types appear as check boxes beside the list. The default is "All" clusters.
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The third criterion is the Calibrations filter (Figure 11.7).

Figure 11.7  Calibration Selection

To apply calibrations, select the Apply this filter checkbox. Choose one or more
calibrations for application by clicking on items in the list. Selected items are marked with
a tick icon appearing beside them. As a short cut, buttons are provided for selecting all or
none. The default is that no Calibrations are applied.

The fourth criteria selection is the Options filter (Figure 11.8).

Figure 11.8  Options Filter

To export PMD and/or fractional polarisation data, select the Apply this filter checkbox.
Select which data sets should be exported to the L1C file. As a short cut, buttons are
provided for selecting all or none.

The fifth criterion is the Type filter. Select this filter with the Apply this filter checkbox.
Choose one or more measurement types for extraction by clicking on items in the list.
Selected items are marked with a tick icon appearing beside them. As a short cut,
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buttons are provided for selecting all or none. The types appear as check boxes beside
the list. The default is "All" clusters. The default is Nadir type only.

Warning: if the Time, Geolocation or Category filters are applied, ensure that there is a
data of the selected type passed through by the other filters.

Click on the Next button to perform the extraction and calibration. A subset of datasets
may be selected for extraction, and the location of the output file is set through a
standard file chooser.

Depending on the performance of the machine, the IO speed, and the range and
calibration types selected, the operation may take a significant time to complete.

When processing large data sets, use the command line tool, SciaL1C, in batch mode.

11.4 Saving a Data Set Record in HTML

Choose Save from the File menu, when using an HTML View.

11.5 Saving Individual Data Fields

Data extracted for a graph may be viewed in tabular form, and saved to a text file. See
Extended Plotting Facilities in section 6.3 for more details.

For more advanced export, see the command line tools Pds2Ascii, PdsPixels and
Pds2Hdf (Chapter 14).

11.6 Exporting to Printable Files.

This feature is platform dependent. Choose print from a view of choice. Your printer
drivers may allow you to save the print to a data file.
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12. DECODING LEVEL 0 DATA

This chapter explains how to read level 0 data using EnviView. The principle is identical
to that used for any other data set, however some configuration is necessary before a
particular level 0 field can be read.

12.1 Introduction

The exact contents of a Level 0 MDS is instrument and mode specific. This means for a
specific Level 0 product, the fields in a MDS can be in different locations within the
source packet for each mode of the instrument. The format of level 0 source packets is
not available in the Envisat product format database. However, EnviView is able to
decode and display Level 0 data, if it is provided with a description of which parameters
are contained in a given source packet, and how to retrieve them.

If the configuration for a given Level 0 product is provided, EnviView will display, plot and
extract the information in exactly the same way as for fields in any other product, using
the record View, Graph View, etc.

To enable EnviView to be able to open a Level 0 MDS, a script language has been
developed to enable users to describe the locations and sizes of fields in the source
packet, which EnviView can then decode and display in the normal manner.

User written Level 0 script files contain descriptions of fields to extract from certain
source packets.

If no user script exists for a given Level 0 product, EnviView has a default script which it
can use to open a Level 0 MDS. This default header decodes the Packet Header and the
first 2 fields of the Data Field Header. These fields are the only fields which are constant
in every Level 0 MDS.

The detailed description of the format of each source packet may be found in the Envisat
PGICD [RD.3].

12.2 Introduction to the scripting language

The scripting language is very simple. All it does is define a series of variables, and for
each variable set the properties for that variable. The basic structure of the language is in
the following format.

variableName = Field( variableProperties );

Where:-

• variableName is the name of the variable.
• variableProperties is a list of statements which define the properties of the

variable.

Syntax:- There must be a space before and after the = between variableName and Field.
Syntax:- There must not be a space between the end bracket and the semi colon at the
end of the line.
Syntax:- variableName must be a string without any spaces in it.

Figure 12.1 is an example script file. It is the Default Level 0 script file, defining the first
fields of every source packet. If a user writes their own Level 0 script file, it is
recommended that they include these definitions at the start of the file.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 103 of 141

Figure 12.1 Example Script File

12.3 Variable Properties

The variable properties are a list of properties, which define or initialise the variable. The
syntax of the list is as follows.

( propertyName1 = statement1, propertyName2 = statement2);

Where:-

• PropertyName is a name of the property.

• Statement is a constant or expression which initialises the
property.

Syntax:- There must be a space before and after the = between PropertyName and the
statement.

Syntax:- There must be a comma between each property.

12.3.1 Name Property

Property name = name

The name property defines the name of the variable. If the property is not present, it will
use the variable name as the field name.

12.3.2 Bitoffset Property

Property name = bitoffset

The bitoffset property defines the offset in bits from the start of the Instrument Source
Packet. Bitoffset is expecting an integer.

12.3.3 Size Property

Property name = size

packver = Field( bitoffset = 0, size = 3, type = "IntegerU1", description =
"Packet Version Number");
packtype = Field( bitoffset = 3, size = 1, type = "IntegerU1", description =
"Packet Type");
datafieldflagheader = Field( bitoffset = 4, size = 1, type = "IntegerU1",
description = "Data Field flag header");
AppId = Field( bitoffset = 5, size = 11, type = "BinaryU2", description =
"Application id");

segflag = Field( bitoffset = 16, size = 2, type = "IntegerU1", description =
"Segmentation Flag");
segcounter = Field( bitoffset = 18, size = 14, type = "IntegerU2",
description = "Source Segmentation Counter");

packlen = Field( bitoffset = 32, size = 16, type = "IntegerU2", description
= "packet length");

dataFieldHeaderLength = Field( bitoffset = 48, size = 16, type =
"IntegerU2", description = "data field header length");
modeId = Field( bitoffset = 64, size = 16, type = "BinaryU2", description =
"mode Id");
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The size property defines the size of the field in bits. The size property expects an
integer.

12.3.4 Type Property

Property name = type

The type property defines the type of the field, i.e. is it a string, integer, binary etc. The
type property expects one of the following strings to tell it what is the field type.

Type Description Type Description

AsciiCharacter A character represented
externally as a single
ASCII character

IntegerS2 2 byte signed integer

AsciiFloatNumber A Float represented
externally as a set of
ASCII digits

IntegerS4 4 byte signed integer

AsciiNumber A Number represented
externally as a set of
ASCII digits

IntegerS8 8 byte signed integer

AsciiString A String represented
externally as a set of
ASCII Bytes

IntegerU1 1 byte un-signed integer

BinaryU2 2 byte un-signed binary IntegerU2 2 byte un-signed integer

BinaryU4 4 byte un-signed binary IntegerU4 4 byte un-signed integer

BooleanFlag Boolean represented by a
single byte

IntegerU8 8 byte un-signed integer

FloatDo 8 byte IEEE float Geolocation geographical coordinate
stored in 8 bytes

FloatFl 4 byte IEEE float Utc Coordinated Universal
Time in processing
format

IntegerS1 1 byte signed integer UtcExternal U T C  r e p r e s e n t e d
externally as a 27
character ASCII string

Table 12.1 Field Types

12.3.5 ElementCount Property

Property name = elementCount



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 105 of 141

The element count property defines the number of elements the field has. ElementCount
is expecting an integer.

12.3.6 Units Property

Property name = units

The units property defines the units of the field. units is expecting a String.

12.3.7 Description Property

Property name = description

The description property defines a description of the field. description is expecting a
String. If the description includes spaces, use double quotes to delimit the contents.

12.4 Statements

Statements are used to initialise the field properties. There are several statement types.

12.4.1 Basic Statement

Basic Statement is the most simple statement type. It simple initialise the property with a
string. If spaces are required within the string surround it with quotes. Below are a few
examples of basic statements.

propertyName = some_value;

propertyName = "initialise with this string";

propertyName = 54;

propertyName = 23.67;

The last two example properties have been given a number constant. If the property is
expecting to be initialised with a string, the property value will consist of the digits of the
specified number.

Syntax:- There must be a semi colon at the end of the basic statement.

12.4.2 If Statement

The If Statement is a simple conditional expression. If the result is true the code
(statements) inside the if-statement are executed, if the result is false then the statements
inside are not executed. Below is the syntax of an if statement.

if ( lhsValue condition rhsValue ){
   statements;
}

Where:-

• lhsValue is a left hand side value.

• condition is the condition part of the statement. There are 6
conditions which are excepted, they are:-
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• ==  (equals)
• !=  (not equals)
• <   (less than)
• <=  (less than or equal to)
• > (greater than)
• >= (greater than or equal to)

• rhsValue is the right hand value.

• statements the inner statements which are executed if the if
statement is true.

Syntax:- There must be a space between the if and the (

Syntax:- There must be a space between the lhsValue and the condition.

Syntax:- There must be a space between the condition and the rhsValue.

Syntax:- if rhsValue has spaces in it, it must be surrounded by double quotes.

The lhsValue is a variable (field) already defined within the script. When EnviView is
executing the script, and it comes to an if-statement, it takes the value of the field defined
as a lhsValue and evaluates it against the rhsValue. So if the field is an integer the
rhsValue must be an integer.

A reason to do this might be that the bitoffset of field 'A' in the product is a different value
for each mode the instrument is in. Below is an example script to do this.

AppId = Field( bitoffset = 5, size = 11, type = "BinaryU2", description = "Application id");
A = Field( bitoffset = if (AppId == "0000 0000 1100 0100"){

500
       },
       if (AppId == "0000 0000 1100 1110"){

550
       },
       size = 10;,
       type = "IntegerU2";);

12.4.3 If Else Statement

The if-else-statement is a extension of the if-statement. The Syntax is as follows.

if ( lhsValue condition rhsValue ){
   statements;
}else{
   elseStatments;
}

Syntax:- There must not be any spaces between the curly brackets and the 'else'.

It works in the same way as the if-statement. i.e. the lhsValue is a variable name already
defined in the script. If the if-statement is true then the code inside is executed, if the
condition is false, the code inside the else loop is executed.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 107 of 141

12.4.4 Math Statement

The math statement is provide for the case where the value of a property of a field is
dependent on the value of another field. E.g. the bitoffset of field B is the value of field A
+ a constant. The script for this would look like.

A = Field( bitoffset = 234, size = 16, type = "IntegerU2", description = "field a");
B = Field( bitoffset = A + 25, size = 10;, type = "IntegerU2";);

The math statement can handle the basic math operators, + - * / and can handle
parenthesis. Each term in the expression must be separated by spaces, this includes
parenthesis. Below is an example of a complex math statement.

Bitoffset = (  fieldA  +  25  )  *  ( fieldB – 55  ) ;

12.5 Using Level 0 Scripts

12.5.1 File naming conventions

The file naming convention used by EnviView to find if a Level 0 MDS has a script is as
follows.

ProductType + '_' + DataSetName + '.txt'

e.g. for the MIPAS_SOURCE_PACKETS dataset in a MIP_NL__0P product the script file
name would be:- MIP_NL__0P_MIPAS_SOURCE_PACKETS.txt

12.5.2 Where to save script file

All scripts must be stored in a directory called level0scripts

The location of this directory is relative to the current working directory, the first time a
level 0 data set is opened.

12.5.3 Modifying a script

EnviView reads the script file the first time a dataset is opened. Changes to a script are
only registered by restarting the application.
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12.6 Example

The following script is an example of a MIPAS file, decoding a number of items in the
data field header :-

#
# Source Packet Header
#
packver = Field( bitoffset = 0,size = 3,type = "IntegerU1",description = "Packet Version Number");
packtype = Field( bitoffset = 3, size = 1, type = "IntegerU1", description = "Packet Type");
datafieldflagheader = Field( bitoffset = 4, size = 1, type = "IntegerU1",
                      description = "Data Field flag header");
AppId = Field( bitoffset = 5, size = 11, type = "BinaryU2", description = "Application id");

segflag = Field( bitoffset = 16, size = 2, type = "IntegerU1", description = "Segmentation Flag");
segcounter = Field( bitoffset = 18, size = 14, type = "IntegerU2",
             description = "Source Segmentation Counter");

packlen = Field( bitoffset = 32, size = 16, type = "IntegerU2",
          description = "packgfntenehsgbet length");
#
# Data Field Header
#
dataFieldHeaderLength = Field( bitoffset = 48, size = 16, type = "IntegerU2",
                        description = "data field header length");
modeId = Field( bitoffset = 64, size = 16, type = "BinaryU2", description = "mode Id");
icu_code = Field( bitoffset = 80, size = 32, type = "IntegerU4",
           description = "ICU On Board time code");
packet_type_id = Field( bitoffset = 112, size = 4, type = "IntegerU1",
                 description = "Packet Type ID");
igm_id = Field( bitoffset = 116, size = 16, type = "IntegerU2", description = "IGM ID");
num_blocks = Field( bitoffset = 132, size = 3, type = "IntegerU1",
             description = "Number of blocks in Packet");
b1_src_id  = Field( bitoffset = 144, size = 5, type = "IntegerU1",
             description = "Source ID Block#1");
b1_seq_num = Field( bitoffset = 149, size = 11, type = "IntegerU2",
             description = "Block Sequence Number Block#1");
b1_num_samp = Field( bitoffset = 160, size = 11, type = "IntegerU2",
              description = "Number of Samples Block#1");
b1_num_samp_bits = Field( bitoffset = 171, size = 5, type = "IntegerU1",
                   description = "Number Bits Per Sample Block#2");
b2_src_id  = Field( bitoffset = 176, size = 5, type = "IntegerU1",
             description = "Source ID Block#2");
b2_seq_num = Field( bitoffset = 181, size = 11, type = "IntegerU2",
             description = "Block Sequence Number Block#2");
b2_num_samp = Field( bitoffset = 192, size = 11, type = "IntegerU2",
              description = "Number of Samples Block#2");
b2_num_samp_bits = Field( bitoffset = 203, size = 5, type = "IntegerU1",
                   description = "Number Bits Per Sample Block#2");
b3_src_id  = Field( bitoffset = 208, size = 5, type = "IntegerU1",
             description = "Source ID Block#3");
b3_seq_num = Field( bitoffset = 213, size = 11, type = "IntegerU2",
             description = "Block Sequence Number Block#3");
b3_num_samp = Field( bitoffset = 224, size = 11, type = "IntegerU2",
              description = "Number of Samples Block#3");
b3_num_samp_bits = Field( bitoffset = 235, size = 5, type = "IntegerU1",
                   description = "Number Bits Per Sample Block#3");
b4_src_id  = Field( bitoffset = 240, size = 5, type = "IntegerU1",
             description = "Source ID Block#4");
b4_seq_num = Field( bitoffset = 245, size = 11, type = "IntegerU2",
             description = "Block Sequence Number Block#4");
b4_num_samp = Field( bitoffset = 256, size = 11, type = "IntegerU2",
              description = "Number of Samples Block#4");
b4_num_samp_bits = Field( bitoffset = 267, size = 5, type = "IntegerU1",
                   description = "Number Bits Per Sample Block#4");

Copy  the  con ten ts  o f  t he  above  sc r i p t  i n to  t he  f i l e
MIP_NL__0P_MIPAS_SOURCE_PACKETS.txt, and place the file in a directory called
level0scripts.
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13. GETTING HELP IN ENVIVIEW

13.1 Documentation

This document is intended to provide a complete description of the features of the
EnviView application. If there are any mistakes or omissions, please send the details and
any requests for more information by e:mail to enviview@jw.estec.esa.nl

In addition to this document, a README file is provided with the distribution, containing
installation instructions.

13.2 On-line help

This manual is available as on-line help from within EnviView. Choose EnviView Help
from the Help menu. The manual is broken up into sections. Each section title is
displayed on the left and the contents of the section is displayed on the right hand side.
The window may be resized, open and closed as often as one desires.

Some components also provide tooltips. These are small windows that appear when a
cursor is held above a component (such as a button or a text field) that contain
information or instructions pertinent to that component and its use.
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14. COMMAND LINE TOOLS AND ENVIVIEW

The EnviView package includes not only the GUI based EnviView application, but also a
growing number of tools that may be used directly from the command line. This section
describes how to use each of those tools.

The following tools are provided in the standard EnviView package (version 2.0.1).

• Pds2Ascii – extract field values to an ASCII text file

• Pds2Hdf – extract datasets (and subsets) to an HDF 4 file

• PdsSubset – extract datasets to a smaller PDS child product (i.e. Pds2Pds)

• PdsPixels – extract portions of image datasets to various image file formats

• PdsPixelTrack – extract individual pixels from an image data set, along a given track

• SciaL1C – extract and calibrate Sciamachy measurement data

14.1 Maximising performance

EnviView and all it’s family of command line tools are written in java. Using an efficient
and optimised java runtime is essential for maximising performance of EnviView and it’s
tools. We currently recommend a Java 1.3.1 runtime, using the hotspot VM. The latest
release for Windows, Solaris and linux x86 may be downloaded from

  http://java.sun.com/j2se/1.3/jre/

Mac OS X includes a built in Java 1.3.1 runtime. Updates are included in the standard
operating system updates. Mac OS 9 only provides a Java 1.1 runtime. We strongly
recommend upgrading to Mac OS X for improved performance. Runtimes for other
operating systems are available from the OS vendor.

Furthermore, if running the same command multiple times, improved overall execution
times will be had from using multiple input files on the same command line, or by using
the batch facility, see below.

14.2 Batch files

When starting one of the EnviView command lines tools, the first task that must be
performed is to start the java runtime, and when the command is finished, the runtime
must be closed down. If one is running a tool on multiple files, it may be useful to use the
batch file facility.

Essentially the batch file provides a series of command line arguments to the tool. It’s
advantage is that the java runtime does not have to be restarted for every operation,
thereby reducing the overhead and improving performance.

Note that if the same options are being used for every input file, most commands allow a
list of input files to be given on the command line, alleviating the need to turn to a batch
file.

For the tool <PdsTool>  to make use of a batch file use only the arguments
–b!<batchfile> where <batchfile> is a text file containing a list of command line
arguments, one line per command. For example

Pds2Ascii –b p2a.txt
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Where the file p2a.txt contains:-

-ds 2 –field dsr_time –file time.txt GOM_NL__2PXXXX20011221X103525X0
-ds NL_GEOLOCATION –field lat –file latitude.txt GOM_NL__2PXXXX20011221X103525X0

Each line contains a list of command line arguments for one invocation of the command.
Each of these lines is executed sequentially, from the beginning of the file to the end.

14.3 Tips for using the command line options

14.3.1 Arrow keys on command line under DOS and Windows.

One some versions of windows, the DOS terminal does not provide the ability to edit the
command line with the arrow keys, or re-use previously typed commands. If this is the
case, type DOSKEY, to add the functionality.

14.3.2 Arrow keys on command line under Unix.

One some unix shells, previously typed commands cannot be accessed with the arrow
keys. If this is the case, use a shell such a tcsh, to add the functionality.

14.3.3 Quoting arguments containing spaces.

Some data set names have spaces in them, making it difficult to use as command line
arguments. While various command line shells deal with this issue in different ways, the
most widely accepted method is to place double quotes (“) either side of the argument.
This is also supported in our own batch files.
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14.4 Pds2Ascii

NAME
Pds2Ascii – extracts field values from a dataset in an Envisat PDS format file

and exports to an ASCII text file.

SYNOPSIS

Pds2Ascii [-....] pdsfile1 [pdsfile2...]

DESCRIPTION

Envisat data products are stored in a non-standard file format (PDS). This tool enables
field values from a specified dataset to be output to an ASCII text file.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Additional

help on specific options can also be obtained by adding the option,
including the prefix - at the end.

-list
-l Using this option, a list of the data sets in the product file can be

displayed. This list gives the type of the data set, either annotated (ADS)
or measurement data set (MDS), the name of the data set and the
number of records it contains. In addition, each data set is prefixed with a
unique index that can then be used in the export command to specify the
data set rather than by using the full name.

-listfield “data-set-name”
-listfield n

Using this option, followed by a data set name or index, a list of the fields
in the given dataset are displayed. This list gives the index of the field,
the name of the field, and a description of the field. To list the fields from
the MPH or SPH, use “MPH” or “SPH” respectively, as the datasets have
no index.

EXTRACTING DATA

-batch “file-name”

  Option for grouping multiple command lines. The –batch option is
followed by a file. In this file, multiple command lines are stored. The
program will execute each command line in turn. For a more detailed
description, go to the Batch section.

-ds “data-set-name”, …
-ds n1, n2, …

This option defines which data set will be used for extracting field values.
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To define the dataset either use the data set name or by a unique index
(as declared by the –list option). Data set names with spaces must be
enclosed in quotes.

-field “field-name”, …
-f This option defines which fields from the datasets specified by the –ds

option are exported. Multiple field names are comma delimited.

-file outfile.txt
This option defines the output file. If the option is not used the results are
outputted to screen.

-batch batch.txt
-b Using this option, the tool will run a batch file.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

Pds2Ascii –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 2 –field dsr_time –file time.txt GOM_NL__2PXXXX20011221X103525X0
-ds NL_GEOLOCATION –f lat –file lat.txt GOM_NL__2PXXXX20011221X103525X0

EXAMPLES

Listing the contents of a PDS product

Pds2Ascii -list GOM_NL__2PXXXX20011221X103525X0

The output would look like this

Dataset details :
Index : type :      Data set  name
1 : ads  : NL_GEOLOCATION  (contains  70  records)
2 : ads  : NL_ACCURACY_ESTIMATION (contains 70 records)
3 : gads : NL_SUMMARY_QUALITY (contains 1 records)

Listing the fields from a dataset

Pds2Ascii -listfield 2 GOM_NL__2PXXXX20011221X103525X0

The output would look like

Index   field name       description
1. dsr_time     Start time of the Data Set Record
2. attach_flag  Attachment Flag
...

To Extract fields dsr_time and attach_flag from dataset 2 and output the values into a file
called results.txt
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Pds2Ascii –ds 2 -field dsr_time, attach_flag –file results.txt
GOM_NL__2PXXXX20011221X103525X0

To use a batch file.

Pds2Ascii –b batchfile.bat

The batch file will contain a list of commands will be executed sequentially. Below is an
example of a batchfile

-ds 2 –field dsr_time –file time.txt GOM_NL__2PXXXX20011221X103525X0
-ds NL_GEOLOCATION –f lat –file lat.txt GOM_NL__2PXXXX20011221X103525X0
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14.5 Pds2Hdf

NAME
Pds2Hdf – convert Envisat PDS format files into HDF 4.1

SYNOPSIS

Pds2Hdf [-options] pdsfile1 [pdsfile2...]

DESCRIPTION

Envisat data products are stored in a non-standard file format (PDS). These files can be
converted to the HDF 4.1 specification which can then be read by many common off-the
shelf tools (COTS) for further analysis.

The list of files at the end of the command line will be executed sequentially with the set
of options.

The output file name will be the input file name with ".hdf" appended onto the end.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Help on

specific options can also be obtained by adding the option, including the
prefix - at the end.

-list
-l Using this option, a list of the data sets in the product file can be

displayed. This list gives the type of the data set, either annotated or
measurement data set, name of the data set and the number of records it
contains. In addition, each data set is prefixed with a unique index that
can then be used in the export command to specify the data set rather
than by using the full name.

EXTRACTING DATA

-ds “data-set-name”, …
-ds n1, n2, … This option defines which data sets and their record ranges are used in

creation of the child product. To define the data set either use the data
set name or by a unique index (as declared by the –list option). Data set
names with spaces must be enclosed in quotes. Multiple datasets are
comma delimited. If the option is not used all data sets are used in
creating the child product. To define a record range for these datasets
use the following firstRecord:NumberOfRecords, e.g. –ds 1,2 10:15 this
will select datasets 1 and 2 with records 10 through to 24. If no record
range is provided, it will use all records.

-batch “file-name”
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 Option for grouping multiple command line. The –batch option is followed
by a file. In this file, multiple command lines are stored. The program will
execute each command line in turn. For more information, please go to
the Batch section.

-out “directory-path”
This option specifies the output directory where the program is to place
the produced files. By default, the program places the files in the
directory where the program was executed.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

Pds2Hdf –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 1,2,3 –out C:\OutputDirectory GOM_NL__2PXXXX20011221X103525X0
–ds 1, 2 1:50 GOM_NL__2PXXXX20011221X103525X0

EXAMPLES

Listing the contents of a PDS product

Pds2Hdf –list ASA_IM__BPXXXX20011221X103525X0

The output would look like this

Product  file is : ASA_IM__BPXXXX20011221X103525X0
      pds2hdf v1.1b6
      Data Formats DDT v2.2 EvD 1.1 (22/10/1999)

      Index : type :      Data set  name
      0 : mds  : MDS1  (contains  405  records)

1 : ads  : MDS1 SQ ADS  (contains  1  records)
2 : ads  : GEOLOCATION GRID ADS  (contains  9  records)

Extracting a data set

pds2hdf –ds MDS1 ASA_IM__BPXXXX20011221X103525X0   

In this case, the data sets MDS1 are to be exported. Alternatively, the indices for the data
sets could be found first using the -list option and the same command could have been
entered as

pds2hdf -ds 0  ASA_IM__BPXXXX20011221X103525X0

Exporting a data set record set

pds2hdf -ds MDS1 100:50 ASA_IM__BPXXXX20011221X103525X0

In this case, the product is ASA_IM__BPXXXX20011221X103525X0 and the data set
MDS1 is chosen, but only 50 records starting from the 100th record are to be exported .
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14.6 PdsPixels

NAME
PdsPixels – takes a Envisat PDS format file and extracts an area of pixels from
an Image dataSet.

SYNOPSIS

PdsPixels [-....] pdsfile1 [pdsfile2...]

DESCRIPTION

This tool extracts an area of pixels from an Image dataset. The area can be given in
either pixel co-ordinates or as a geo-location. The area can also be described by a topleft
and bottomright corners of a centre and radius. The output of the pixels for the area can
be one of 5 formats, saved as raw pixel values, binary floating point, ascii text file
delimited by either commas or tabs, or as hdf output.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Help on

specific options can also be obtained by adding the option, including the
prefix - at the end.

-list
-l Using this option, a list of the Image data sets in the product file can be

displayed. For each image dataset, it will also list the quantities for the
image. This list gives the type of the data set, either annotated (ADS) or
measurement data set (MDS), name of the data set and the number of
records it contains. In addition, each data set is prefixed with a unique
index that can then be used with the –dataset option to specify the data
set rather than by using the full name. The list of quantities display the
quantity name with an index.

EXTRACTING DATA

-batch “file-name”

  Option for grouping multiple command lines. The –batch option is
followed by a file. In this file, multiple command lines are stored. The
program will execute each command line in turn. For a more detailed
description, go to the Batch section.

-dataset “data-set-name”, …
-dataset n1, n2, …
-ds This option defines which image data sets are to be used. To define the

data set either use the data set name or its unique index (as declared by
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the –list option). Data set names with spaces must be enclosed in
quotes. Multiple datasets are comma delimited.

-quantity “quantity-name”, …
-quantity n1, n2, …
-q This option defines which quantities are used to extract the pixel values.

To define a quantity use either the name or index (as declared by the
–list option). Multiple quantities are comma delimited. If option is not used
the default quantity is used.

-out “directory-path”
This option defines the output directory. If the option is not used the
output directory is the current working directory.

-pixelcoord
-p This option defines that the pixel area is declared in pixel co-ordinates. If

this option is not used then by default, the area is assumed to be
declared in geo-location.

-topleft n1 n2
The top left corner of the area. The co-ordinates which follow the option
are separated by a space. Pixel co-ordinates are integers and geo-
locations are floats. Must be used with the –bottomright option.

-bottomright n1 n2
The bottom right corner of the area. The co-ordinates which follow the
option are separated by a space. Pixel co-ordinates are integers and
geo-locations are floats. Must be used with the –topleft option.

-centre n1 n2
The centre point of the area. The co-ordinates which follow the option are
separated by a space. Pixel co-ordinates are integers and geo-locations
are floats. Must be used with the –radius option.

-radius n1 n2
The radius of the area (in a vertical and horizontal directions). The co-
ordinates which follow the option are separated by a space. Pixel co-
ordinates are integers and geo-locations are floats. Must be used with the
–centre option.

-floatingPoint
-f Use this option to set the output to be binary floating point. Cannot be

used with options -asciiTab, -asciiComma or –hdf. If none of these
options are set the output will be in raw pixels values.

-asciiTab
-at Use this option to set the output to be ascii text file, tab delimited. Cannot

be used with options -floatingPoint, -asciiComma or –hdf. If none of these
options are set the output will be in raw pixels values.

-asciiComma
-ac Use this option to set the output to be ascii text file, comma delimited.

Cannot be used with options -floatingPoint, -asciiTab or –hdf. If none of
these options are set the output will be in raw pixels values.

-hdf Use this option to set the output to be hdf. Cannot be used with options -
floatingPoint, -asciiComma or -asciiTab. If none of these options are set
the output will be in raw pixels values.



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 119 of 141

-littleEndian
-le Use this option to save the binary files in Little Endian format. If this

option is not used it will save binary files in Big Endian Format. This
option is only used when the output type is raw pixels or floating point.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

PdsPixels –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 3 –q 0 –f –centre 25.657 –45.685 –radius 5 10 -le
ASA_IM__BPXXXX20011221X103525X0
-ds 3 –q 0 –hdf –p –topleft 50 100 –bottomright 200 300
ASA_IM__BPXXXX20011221X103525X0

EXAMPLES

Listing the image data sets of a PDS product

PdsPixels -list ASA_IM__BPXXXX20011221X103525X0

The output would look like this

Dataset details :
Index : type :     Data set  name
3 : mds  : MDS1  (contains  5355  records)
  quantity index 0      : name pixel

To extract pixels  50, 100 to 200, 300 from data set MDS1 quantity 0 and save the file in
hdf format.

PdsPixels -ds 3 –q 0 –hdf –p –topleft 50 100 –bottomright 200 300
ASA_IM__BPXXXX20011221X103525X0

To extract from a centre point 25.657N –45.685E with radius +5 N/S +10 E/W from data
set MDS1 quantity 0 and save the file in floating point format in Little Endian.

PdsPixels -ds 3 –q 0 –f –centre 25.657 –45.685 –radius 5 10 -le
ASA_IM__BPXXXX20011221X103525X0

To use a batch file.

PdsPixels –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 3 –q 0 –f –centre 25.657 –45.685 –radius 5 10 -le
ASA_IM__BPXXXX20011221X103525X0
-ds 3 –q 0 –hdf –p –topleft 50 100 –bottomright 200 300
ASA_IM__BPXXXX20011221X103525X0
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14.7 PdsPixelTrack

NAME
PdsPixelTrack – takes a Envisat PDS format file and extracts individual pixels
from an Image dataSet.

SYNOPSIS

PdsPixelTrack [-....] pdsfile1 [pdsfile2...]

DESCRIPTION

This tool extracts individual pixels from an Image dataset. The pixels to extract are listed
in a text file and can be stored as either a pixel co-ordinate or as a geo-location. The
output is a text file which list the value, the pixel co-ordinate and the geo-location.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Help on

specific options can also be obtained by adding the option, including the
prefix - at the end.

-list
-l Using this option, a list of the Image data sets in the product file can be

displayed. For each image data set, it will also list the quantities for the
image. This list gives the type of the data set, either annotated (ADS) or
measurement data set (MDS), name of the data set and the number of
records it contains. In addition, each data set is prefixed with a unique
index that can then be used with the –dataset option to specify the data
set rather than by using the full name. In the Quantity list, for each
quantity, it will list the quantities name with an index.

EXTRACTING DATA

-batch “file-name”

  Option for grouping multiple command lines. The –batch option is
followed by a file. In this file, multiple command lines are stored. The
program will execute each command line in turn. For a more detailed
description, go to the Batch section.

-dataset “data-set-name”, …
-dataset n1, n2, …
-ds This option defines which image data sets are to be used. To define the

data set either use the data set name or its unique index (as declared by
the –list option). Data set names with spaces must be enclosed in
quotes. Multiple datasets are comma delimited.

-quantity “quantity-name”, …
-quantity n1, n2, …
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-q This option defines which quantities are used to extract the pixel values.
To define a quantity use either the name or index (as declared by the
–list option). Multiple quantities are comma delimited. If option is not used
the default quantity is used.

-out “directory-path”
This option defines the output directory. If the option is not used the
output directory is the current working directory.

-input “file-name”
This option defines the input file. The input file contains a list of pixels to
extract.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

PdsPixelTrack –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 3 –input pixels1.txt ASA_IM__BPXXXX20011221X103525X0
-ds 3 –input pixels2.txt ASA_IM__BPXXXX20011221X103525X0
-ds 3 –input pixels3.txt ASA_IM__BPXXXX20011221X103525X0

EXAMPLES

Listing the image data sets of a PDS product

PdsPixelTrack -list ASA_IM__BPXXXX20011221X103525X0

The output would look like this

Dataset details :
Index : type :     Data set  name
3 : mds  : MDS1  (contains  5355  records)
  quantity index 0      : name pixel

To extract some pixels from data set MDS1 quantity 0

PdsPixelTrack -ds 3 –q 0 –input pixels.txt
ASA_IM__BPXXXX20011221X103525X0

Where pixels.txt contains the list of pixel co-ordinates and/or geolocations. The format of
the pixels.txt would be.

125 256
569 6
25.678 –45.689
28.159 -42.753
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The numbers which are integers represent pixel co-ordinates and the numbers which are
floats represent the latitude and longitudes.

To use a batch file.

PdsPixelTrack –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 3 –input pixels1.txt ASA_IM__BPXXXX20011221X103525X0
-ds 3 –input pixels2.txt ASA_IM__BPXXXX20011221X103525X0
-ds 3 –input pixels3.txt ASA_IM__BPXXXX20011221X103525X0
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14.8 PdsSubset

NAME
PdsSubset – takes a Envisat PDS format file and creates a child product which
contains a subset of the data.

SYNOPSIS

PdsSubset [-....] pdsfile1 [pdsfile2...]

DESCRIPTION

This tool creates child product files which contain a subset of the data from the parent
product. The subset of data is created by defining data sets to use, record ranges within
those data sets and a time range.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Help on

specific options can also be obtained by adding the option, including the
prefix - at the end.

-list
-l Using this option, a list of the data sets in the product file can be

displayed. This list gives the type of the data set, either annotated (ADS)
or measurement data set (MDS), name of the data set and the number of
records it contains. In addition, each data set is prefixed with a unique
index that can then be used with the –dataset option to specify the data
set rather than by using the full name.

EXTRACTING DATA

-batch “file-name”

  Option for grouping multiple command lines. The –batch option is
followed by a file. In this file, multiple command lines are stored. The
program will execute each command line in turn. For a more detailed
description, go to the Batch section.

-ds “data-set-name”, …
-ds n1, n2, … This option defines which data sets and their record ranges are to be

used in creating the child product. To define the data set either use the
data set name or its unique index (as declared by the –list option). Data
set names with spaces must be enclosed in quotes. Multiple data sets
are comma delimited. If the option is not used all data sets are used in
creating the child product. To define a record range for these datasets
use the following firstRecord:NumberOfRecords. E.g. –ds 1,2 10:15 this
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will select datasets 1 and 2 with records 10 through to 24. If no record
range is provide it will use all records.

-out “directory-path”
This option defines the output directory. If the option is not used the
output directory is the current working directory.

-starttime t
This option defines the start time in a time range filter. It must be used
with the –stoptime option. The format used for the time is DD-MMM-
YYYY HH:MM:SS e.g. 15-JAN-2001 17:53:49

-stoptime t
This option defines the stop time in a time range filter. It must be used
with the –starttime option. The format used is the same as starttime.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

PdsSubset –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 1,2,3 –out C:\OutputDirectory GOM_NL__2PXXXX20011221X103525X0
–ds 1, 2 1:50 –starttime 15-JAN-2001 17:53:20 –stoptime 15-JAN-2001
17:53:50 GOM_NL__2PXXXX20011221X103525X0

EXAMPLES

Listing the contents of a PDS product

PdsSubset -list GOM_NL__2PXXXX20011221X103525X0

The output would look like this

Dataset details :
Index : type :      Data set  name
1 : ads  : NL_GEOLOCATION  (contains  70  records)
2 : ads  : NL_ACCURACY_ESTIMATION (contains 70 records)
3 : gads : NL_SUMMARY_QUALITY (contains 1 records)

To create a child product containing all the records in data set 1 and record 10 to 25 in
dataset 2

PdsSubset -ds 1 –ds 2 10:15 GOM_NL__2PXXXX20011221X103525X0



EnviView User Guide 21 August, 2002
Version 2.0.7 Issue 2.0.7

VEGA Group PLC Page 125 of 141

To create a child product containing records 1 to 50 in dataset 1 and 2 and those within
the time period 17:53:20 and 17:53:50 on 15-JAN-2001

PdsSubset –ds 1, 2 1:50 –starttime 15-JAN-2001 17:53:20 –stoptime 15-JAN-
2001 17:53:50 GOM_NL__2PXXXX20011221X103525X0

To use a batch file.

PdsSubset –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile

-ds 1,2,3 –out C:\OutputDirectory GOM_NL__2PXXXX20011221X103525X0
–ds 1, 2 1:50 –starttime 15-JAN-2001 17:53:20 –stoptime 15-JAN-2001
17:53:50 GOM_NL__2PXXXX20011221X103525X0
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14.9 SciaL1C

NAME
SciaL1C – convert Envisat Sciamachy Level 1B file to a Sciamachy Level 1C file

SYNOPSIS

SciaL1C [-options] sciafile1 [ sciafile2... ]

DESCRIPTION

The Sciamachy Level 1B files have non-calibrated measurement data. These files can be
exported to the intermediate Level 1C file specification, which are calibrated to the user
specification and then can be used for further analysis. The description of the Level 1C
MDS can be found in the EnviView help section.

The defaults for this command line are only type Nadir is exported; no calibrations are
applied; no PMD data is exported; no Fractional Polarisation data is exported. The type
default changes to "all types exported" if the category, time (-starttime, -stoptime) or
geolocation (-topleft, -topright) filters are applied.

The list of files at the end of the command line will be executed sequentially with the set
of options.

The output file name will be the input file name with ".child" appended onto the end.

The options are all pre-fixed with a ‘-‘ and may be followed by one or more parameters.
Some options have shortened forms that can be used instead of the long option name.
The available options are:

RETRIEVING INFORMATION

-help
-h A description of the tool with some examples is printed out. Help on

specific options can also be obtained by adding the option, including the
prefix - at the end.

-list
-l Using this option, a list of the data sets in the product file can be

displayed. This list gives the type of the data set, either annotated or
measurement data set, name of the data set and the number of records it
contains. In addition, each data set is prefixed with a unique index that
can then be used in the export command to specify the data set rather
than by using the full name.

EXTRACTING DATA

-ds “data-set-name”, …
-ds n1, n2, …

This option defines which datasets are used in creation of the child
product. To define the data set either use the data set name or its unique
index (as declared by the –list option). Data set names with spaces must
be enclosed in quotes. Multiple datasets are comma delimited. If the
option is not used, by default, all data sets are used in creating the child
product.
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-out “directory-path”

 This option specifies the output directory where the program is to place
the produced files. By default, the program places the files in the directory
where the program was executed.

-batch “file-name”

  Option for grouping multiple command lines. The –batch option is
followed by a file. In this file, multiple command lines are stored. The
program will execute each command line in turn. For a more detailed
description, go to the Batch section.

CALIBRATION OPTIONS

-allcalibrations
-allcal Option for specifying that all calibrations are applied to the data.

-calibration n1, n2, …
-cal n1, n2, … Option used to define the calibrations applied to the exported data. The

values 0 to 7 are entered, comma delimited. The default is no calibrations
applied. If wavelength calibration is not specified then Polarisation or
Radiance calibration cannot be completed. These values correspond to
0 :: Memory Effect  Correction
1 :: Leakage Correction
2 :: StrayLight Correction
3 :: PPG Correction
4 :: Etalon Correction
5 :: WaveLength Calibration
6 :: Polarisation Sensitivity Calibration
7 :: Radiance Sensitivity Calibration

-category n1, n2, …
-cat n1, n2, … Option used to export specific measurement categories. The categories

indexes 0-N are entered comma delimited. For a list of these categories
and their indexes, use the SciaL1C –help –cat command. This list is
liable to change. Hence, it is dependant on the version of EnviView
currently used.

-cluster n1, n2, …
-clus n1, n2, … Option used to define a list of clusters to be exported. A list of cluster

indexes (1 to 64); comma delimited is supplied after the option.

-limbcluster n1, n2, …
-limbclus  n1, n2, …  Option used to define a list of Limb clusters to be exported. A list of

cluster indexes (1 to 64); comma delimited is supplied after the option.

-moncluster n1, n2, …
-monclus n1, n2, …  Option used to define a list of Monitoring clusters to be exported. A

list of cluster indexes (1 to 64); comma delimited is supplied after the
option.

-nadircluster n1, n2, …
-nadirclus n1, n2, …  Option used to define a list of Nadir clusters to be exported. A list

of cluster indexes (1 to 64); comma delimited is supplied after the option.
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-occcluster n1, n2, …
-occclus n1, n2, …  Option used to define a list of Occultation clusters to be exported. A

list of cluster indexes (1 to 64); comma delimited is supplied after the
option.

-noclus
Option used to export no cluster. No Measurement datasets will be
output.

-fracpol
Option used to produce the Fraction Polarisation Level 1C MDS. The
default is that is not used.

-pmd
Option used to produce a PMD Level 1C MDS. The default is that this is
not produced.

-bottomright n1 n2
   This option defines the bottom right co-ordinate in a geolocation filter. It

must be used with the –topleft option. The format used for the co-ordinate
is longitude latitude  e.g. 23 45.5

-topleft n1 n2
            This option defines the top left co-ordinate in a geolocation filter. It must

be used with the –bottomright option. The format used for the location is
longitude latitude e.g. 23 45.5

-starttime t
This option defines the start time in a time range filter. It may be used
with the –stoptime option if the –stoptime is not used the stopime is taken
from the stop time of the product. The format used for the time is DD-
MMM-YYYY HH:MM:SS e.g. 15-JAN-2001 17:53:49

-stoptime t
This option defines the stop time in a time range filter. It may be used
with the –starttime option, if the –starttime is not used the startime is
taken from the start time of the product. The format used is the same as
starttime.

-type “option”, …
Option to set the type of measurement data exported. The options are
'limb '  ' nadir '  ' occultation '  ' monitoring '  ' all '. These options are listed
comma delimited after –type. Default is type nadir except if a category,
time or geolocation filter is applied. In this case, all types are exported.

BATCH

This option is followed by a batch filename. In the batch file, there are multiple command
lines each on a separate line. Each of these separate command lines will be executed
sequentially.

To use a batch file.

SciaL1C –b batchfile.bat

The batch file will contain a list of commands that will be executed sequentially. Below is
an example of a batchfile
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-ds 1,2,3 –out C:\OutputDirectory SCI_NL__1PTD-
P19960620_103652_00004200A001_00179_00176_0000.N1
–ds 1, 2 -allcal SCI_NL__1PTDP19980620_A.N1

EXAMPLES

Listing the contents of a Level1B product

SciaL1C –list SCI_NL__1PTD-
P19960620_103652_00004200A001_00179_00176_0000.N1

Extracting a list of clusters and specifying the calibrations

SciaL1C –cal 0,1 –nadirclus 1,2,3 –limbclus 6,7 SCI_NL__1PTD-
P19960620_103652_00004200A001_00179_00176_0000.N1

This will extract Nadir clusters 1, 2, and 3, and limb clusters 6 and 7 and export them
applying memory effect and leakage correction.

Extracting a type and all calibrations:

SciaL1C –allcal –type nadir,occultation SCI_NL__1PTD-
P19960620_103652_00004200A001_00179_00176_0000.N1

This will extract all nadir and occultation clusters and export them applying all
calibrations.

Extracting a data set and Fractional Polarisation values.

SciaL1C –ds "NEW_LEAKAGE" –noclus -fracpol SCI_NL__1PTD-
P19960620_103652_00004200A001_00179_00176_0000.N1

This extracts the fractional polarisation values for all types with no cluster data and
copies the NEW_LEAKAGE dataset to the level 1C product.
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Appendix A  Installing EnviView

In short, double click on the installer for your platform, provided on the CD-ROM.

Full details of installing the EnviView package is provided in a separate document. Please refer to
the README.txt (or README.pdf, or README.htm) on the CD-ROM distribution for detailed
instructions on installation.
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Appendix B .Processing EnviView Data with IDL

EnviView can export Envisat data products, and data sets to HDF files. The HDF format
is supported by many off the shelf data analysis tools, including Noesys, IDL, ENVI from
Research Systems Inc, and PV-Wave from Visual Numerics.

This chapter includes instructions and examples of reading HDF data exported from
EnviView in IDL. NOTE: HDF support in EnviView requires the addition of a native library
compiled for your platform. If the library is not available, or EnviView cannot locate it, the
menu options referred to below are not accessible. Choose 'About EnviView in the Help
menu to determine whether EnviView can locate the correct library. In case of difficulty,
please refer to the installation instructions.

A detailed description of the organisation of Envisat data in HDF4 files is given in Section
11.2.1.

For further information about HDF, please refer to the NCSA HDF 4 User Guide and
Reference guide provided on the EnviView CD.

B.1 Introduction to examples

A set of utility functions is used here for reading this data into your own IDL programs.
For your convenience, all these routines have been collected together in one file
EnvisatHdf.pro. The contents of this file are listed at the end of this appendix.

To prepare these examples, the simulated L1B and L2 AATSR data files were converted
as follows: -

pds2hdf -p ATS_TOA_1PTRAL19950510_071649_00000000X000_00000_00000_0000.N1
-out L1.hdf

pds2hdf -p ATS_NR__2PTRAL19950510_071649_00000000X000_00000_00000_0000.N1
-out L2.hdf

NOTE These examples are not specific to AATSR. The same principles are used to read
any data element from an Envisat HDF file. Only the Data Set name and variable names
need to change. The List utility functions allow a user to determine the names of any
items in the file.

The important concepts are that all fields for a given data set in the Envisat file are stored
together in a group in the HDF file. Scalar fields are collected in a table (VData), with one
row (record) per Envisat data set record. Array fields are stored as individual array
objects (SDS).

The following examples demonstrate how to read items from a VData or SDS into IDL
variables. For further information, read Chapter 3 of the IDL manual "Scientific Data
Formats", and feel free to inspect the code if the utilities in EnvisatHdf.pro

B.2 Load the utilities into IDL 

Copy the EnvisatHdf.pro file from the EnviView CD to the local directory. Then type the
following at the IDL prompt.

IDL> .run EnvisatHdf.pro

This file provides a set of convenience routines to make reading Envisat data from HDF
files much easier.
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B.3 Listing the datasets in an Envisat HDF file 

Using the utilities, to List the Envisat data sets in the HDF file :-

IDL> listPdsDataSets, "L1.hdf"
MPH
SPH
SUMMARY_QUALITY_ADS
GEOLOCATION_ADS
SCAN_PIXEL_X_AND_Y_ADS
NADIR_VIEW_SOLAR_ANGLES_ADS
FWARD_VIEW_SOLAR_ANGLES_ADS
VISIBLE_CALIB_COEFS_GADS
NADIR_VIEW_SCAN_PIX_NUM_ADS
FWARD_VIEW_SCAN_PIX_NUM_ADS
11500_12500_NM_NADIR_TOA_MDS
10400_11300_NM_NADIR_TOA_MDS
03505_03895_NM_NADIR_TOA_MDS
01580_01640_NM_NADIR_TOA_MDS
00855_00875_NM_NADIR_TOA_MDS
00649_00669_NM_NADIR_TOA_MDS
00545_00565_NM_NADIR_TOA_MDS
11500_12500_NM_FWARD_TOA_MDS
10400_11300_NM_FWARD_TOA_MDS
03505_03895_NM_FWARD_TOA_MDS
01580_01640_NM_FWARD_TOA_MDS
00855_00875_NM_FWARD_TOA_MDS
00649_00669_NM_FWARD_TOA_MDS
00545_00565_NM_FWARD_TOA_MDS
NADIR_VIEW_CONFIDENCE_MDS
FWARD_VIEW_CONFIDENCE_MDS
NADIR_VIEW_CLOUD_MDS
FWARD_VIEW_CLOUD_MDS

IDL> listPdsDatasets, "L2.hdf"
MPH
SPH
SUMMARY_QUALITY_ADS
GEOLOCATION_ADS
SCAN_PIXEL_X_AND_Y_ADS
NADIR_VIEW_SOLAR_ANGLES_ADS
FWARD_VIEW_SOLAR_ANGLES_ADS
NADIR_VIEW_SCAN_PIX_NUM_ADS
FWARD_VIEW_SCAN_PIX_NUM_ADS
DISTRIB_SST_CLOUD_LAND_MDS

B.4 Listing the contents of an Envisat HDF data set

Each data set is a HDF VGroup (a kind of inner directory), named after the DS_NAME of
the data set (in the DSD at the beginning of the Envisat file). Each one contains a VData
table (also named after the DS_NAME) which contains all the scalar variables in the data
set. Array variables are stored in individual SDS within the same VGroup.

To list the variables in a data set :-

IDL> listpdsdataset, "L1.hdf", '00649_00669_NM_FWARD_TOA_MDS'
00649_00669_NM_FWARD_TOA_MDS
     00649_00669_NM_FWARD_TOA_MDS        2272 records
        .Record Index  ULONG
        .dsr_time  DOUBLE
        .quality_flag  BYTE
        .img_scan_y  LONG
     bt_rad_pix (SDS) : INT [512,2272]
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This first lists the scalar variables in the Vdata table, which has the same name as the
Vgroup ( the data set DS_NAME). There is one value per record (2272 records). These
variables are :-

record index, dsr time, quality flag and image scan line y

It then lists the array variables (SDS), in this case the image pixels, a 2d array, 512 pixels
by 2272 records, named bt_rad_pix.

B.5 Reading data from an SDS

This example function will return an entire image into an IDL variable :-

FUNCTION LoadEnvisatImage, filename, datasetname, pixelfieldname

    ; Open The HDF file

    Hid = HDF_OPEN(filename, /READ)

    ; Start the SD interface

    SDid = HDF_SD_START(filename, /READ)

    ; Open the VGroup table containing the image field

    SDSid = DATASET_SDS_ATTACH(Hid, SDid, datasetname, pixelfieldname)

    IF (SDSid EQ -1) THEN BEGIN
        PRINT, "Data Set '"+datasetname+"."+pixelfieldname+"' not found."
        HDF_SD_END, SDid
        HDF_CLOSE, Hid
        RETURN, -1
    ENDIF

    ; Get information about the size of the data

    HDF_SD_GETINFO, SDSid, DIMS = dimensions

    ; Read the data

    HDF_SD_GETDATA, SDSid, pixels

    ; Close the SDS

    HDF_SD_ENDACCESS, SDSid

    ; Close the HDF file

    HDF_SD_END, SDid
    HDF_CLOSE, Hid

    return, pixels
END

This function might be used as follows :-

IDL> img=loadEnvisatImage("L1.hdf", '00649_00669_NM_FWARD_TOA_MDS',
'bt_rad_pix')

The size of the resulting image :-

IDL> help, img
IMG             INT       = Array[512, 2272]
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Displaying part of the image :-

IDL> tvscl, img(*,1500:2000)

B.6 Reading data from a Vdata

Here is an example function reading the time and image scan parameters from the VData
table in the same data set.

PRO PlotScanVsTime, filename

    ; Open The HDF file

    Hid = HDF_OPEN(filename, /READ)

    ; Open the VData table containing the scalar values

    datasetname = '00649_00669_NM_FWARD_TOA_MDS'

    VDname = datasetname

    VDid = DATASET_VD_ATTACH(Hid, datasetname, VDname)

    IF (VDid EQ -1) THEN BEGIN
        PRINT, "Data Set '"+datasetname+"."+VDname+"' not found."
        HDF_CLOSE, Hid
        RETURN
    ENDIF

    ; Determine how many records are in the table

    HDF_VD_GET, VDid, count=totalrecs

    ; Read the time values from all records

    Nrec = HDF_VD_READ(VDid, time, FIELDS="dsr_time", NRECORDS=totalrecs)

    ; Rewind the record counter

     HDF_VD_SEEK, VDid, 0

    ; Read the image scan y field

     Nrec = HDF_VD_READ(VDid, scany, FIELDS="img_scan_y",NRECORDS=totalrecs)

    ; Close the VData table

    HDF_VD_DETACH, VDid

    HDF_CLOSE, Hid

      ; Plot the data

      plot, time, scany
END
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B.7 EnvisatHdf.pro

The contents of the EnvisatHdf.pro is listed for reference below. It includes the following
functions :-

Three routines that list the data in an Envisat HDF file.

• List all the PDS data sets in the named HDF file

PRO ListPdsDataSets, filename

• List all the fields in the named PDS data set in the named HDF file

PRO ListPdsDataSet, filename, datasetname

• List all the fields in all PDS data sets in the named HDF file

PRO ListPdsDataSetFields, filename

HINT: These routines are very helpful in determining the names used for specific data
sets or fields. These names can also be consulted in EnviView under the product formats
menu, or while plotting data.

Two functions that attach to Envisat data structures in an HDF file:

• Attach to an SDS given a dataset name and the SDS (field) name. Returns SDSid.

FUNCTION DATASET_SDS_ATTACH, Hid, SDid, DATASET_NAME, SDS_NAME

Hid is provided by the IDL function HDF_OPEN (Close with HDF_CLOSE)
SDid is provided by HDF_SD_START (End with HDF_SD_END)

Use the IDL routines

HDF_SD_GETINFO to obtain information about the SDS

HDF_SD_GETDATA to read from the SDS

HDF_SD_ENDACCESS to close the SDS

• Attach to an Vdata given a dataset name and the Vdata name. Returns VDid

FUNCTION DATASET_VD_ATTACH, Hid, DATASET_NAME, VDATA_NAME

Hid is provided by the IDL function HDF_OPEN (Close with HDF_CLOSE)

Use the IDL routines

HDF_VD_GET to obtain information about the Vdata

HDF_VD_READ to read records from the Vdata

HDF_VD_SEEK to skip records in the Vdata

HDF_VD_DETATCH to close the Vdata
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;----------------------------- Utility functions -----------------------------;

;
; Search an open VGroup for a named VData
;
; return the HDF REF to the VData
;
FUNCTION GET_VDATA_REF, Hid, VGid, VDname

N = HDF_VG_NUMBER(VGid)

FOR i = 0, N-1 DO BEGIN
HDF_VG_GETTR, VGid, i, TAG, REF
IF (HDF_VG_ISVD(VGid, REF)) THEN BEGIN

VDid = HDF_VD_ATTACH(Hid, REF)

HDF_VD_GET, VDid, NAME=VD_NAME
HDF_VD_DETACH, VDid

IF VD_NAME EQ VDname THEN return, REF
ENDIF

ENDFOR

return, -1
END

;
; Search an open VGroup for a named SDS
;
; return the HDF REF to the SDS
;
FUNCTION GET_SDS_REF, SDid, VGid, SDSname

N = HDF_VG_NUMBER(VGid)

FOR i = 0, N-1 DO BEGIN
HDF_VG_GETTR, VGid, i, TAG, REF

; Check to see if it is an SDS

IF (TAG EQ 720) THEN BEGIN

SDSidx = HDF_SD_REFTOINDEX(SDid, REF)

SDSid = HDF_SD_SELECT(SDid, SDSidx)

HDF_SD_GETINFO, SDSid, NAME=SDS_NAME
HDF_SD_ENDACCESS, SDSid

IF SDS_NAME EQ SDSname THEN return, REF
ENDIF

ENDFOR

return, -1
END
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;
; Search an open VGroup for a named SDS
;
; return the SDS index
;
FUNCTION GET_SDS_INDEX, SDid, VGid, SDSname

N = HDF_VG_NUMBER(VGid)

FOR i = 0, N-1 DO BEGIN
HDF_VG_GETTR, VGid, i, TAG, REF

; Check to see if it is an SDS

IF (TAG EQ 720) THEN BEGIN

SDSidx = HDF_SD_REFTOINDEX(SDid, REF)

SDSid = HDF_SD_SELECT(SDid, SDSidx)

HDF_SD_GETINFO, SDSid, NAME=SDS_NAME
HDF_SD_ENDACCESS, SDSid

IF SDS_NAME EQ SDSname THEN return, SDSidx
ENDIF

ENDFOR

return, -1
END

;
; Search the top level directory for a named VGroup
;
; return the HDF REF to the VGroup
;
FUNCTION GET_VGROUP_REF, Hid, VGname

  VGs = HDF_VG_LONE(Hid)

  IF VGs(0) EQ -1 THEN RETURN, -1

N = N_ELEMENTS(VGs)

FOR i = 0, N-1 DO BEGIN
  VGid = HDF_VG_ATTACH(Hid, VGs(i))
  HDF_VG_GETINFO, VGid, NAME=DS_NAME
  HDF_VG_DETACH, VGid
  
  IF (DS_NAME EQ VGname) THEN RETURN, VGs(i)

ENDFOR

return, -1
END
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;
; Attach to a named Vdata in a named Vgroup
;
; Hid
;          Identifier of the HDF file (fromHDF_OPEN)
;
; DATASET_NAME
;          name of the data set (VGroup)
; VDATA_NAME
;          name of the VData in the VGroup
;
FUNCTION DATASET_VD_ATTACH, Hid, DATASET_NAME, VDATA_NAME

VG_REF = GET_VGROUP_REF(Hid, DATASET_NAME)

IF (VG_REF EQ -1) THEN RETURN, -1

VGid = HDF_VG_ATTACH(Hid, VG_REF)

; Find the VData with the given name

VD_REF = GET_VDATA_REF(Hid, VGid, VDATA_NAME)

HDF_VG_DETACH, VGid

IF (VD_REF EQ -1) THEN RETURN, -1

VDid = HDF_VD_ATTACH(Hid, VD_REF)

RETURN, VDid
END

;
; Attach (Select) to a named SDS in a named Vgroup
;
; Hid
;          Identifier of the HDF file (from HDF_OPEN)
;
; SDid
;          Identifier of the SD i/f to the file (from HDF_SD_START)
;
; DATASET_NAME
;          name of the data set (VGroup)
; SDS_NAME
;          name of the SDS in the VGroup
;
FUNCTION DATASET_SDS_ATTACH, Hid, SDid, DATASET_NAME, SDS_NAME

VG_REF = GET_VGROUP_REF(Hid, DATASET_NAME)

IF (VG_REF EQ -1) THEN RETURN, -1

VGid = HDF_VG_ATTACH(Hid, VG_REF)

; Find the SDS with the given name

SDS_INDEX = GET_SDS_INDEX(SDid, VGid, SDS_NAME)

HDF_VG_DETACH, VGid

IF (SDS_INDEX EQ -1) THEN RETURN, -1

SDSid = HDF_SD_SELECT(SDid, SDS_INDEX)

RETURN, SDSid
END
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;------------------------------- List Functions -------------------------------;

;
; List the fields in a given VGroup
;
; Hid
;        HDF file ID returned by HDF_OPEN
; REF
;        VGroup REF
;
PRO ListPdsVGroupFields, Hid, SDid, REF

VGid = HDF_VG_ATTACH(Hid, REF)
HDF_VG_GETINFO, VGid, NAME=DS_NAME, CLASS=DS_CLASS, NENTRIES=DS_ENTRIES
IF (DS_CLASS EQ "PDS Data Set Record") THEN BEGIN

Print, DS_NAME

; Find the VData with the same name as the VGroup

MAIN_REF=GET_VDATA_REF(Hid, VGid, DS_NAME)

; List it's fields

ListVData, Hid, MAIN_REF

; List the fields of any other groups

N = HDF_VG_NUMBER(VGid)

FOR j = 0, N-1 DO BEGIN

HDF_VG_GETTR, VGid, j, TAG, REF
IF (HDF_VG_ISVD(VGid, REF) AND (REF NE MAIN_REF)) THEN BEGIN

ListVData, Hid, REF
ENDIF ELSE IF (TAG EQ 720) THEN BEGIN ; is SDS

ListSDS, SDid, REF
ENDIF

ENDFOR

ENDIF
HDF_VG_DETACH, VGid

END
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;
; List the fields in a given VData
;
; Hid
;        HDF file ID returned by HDF_OPEN
; REF
;        VData REF returned by HDF_VG_GETTR
;
PRO ListVData, Hid, REF

VDid = HDF_VD_ATTACH(Hid, REF)

HDF_VD_GET, VDid, NAME=VD_NAME, NFIELDS=VD_FIELD_COUNT, COUNT=VD_RECORD_COUNT

PRINT, "     ",VD_NAME, VD_RECORD_COUNT, " records"

FOR i=0, VD_FIELD_COUNT-1 DO BEGIN
HDF_VD_GETINFO,VDid, i, NAME=FIELD_NAME, TYPE=FIELD_TYPE, 

ORDER=FIELD_ELEMENTS
IF (FIELD_ELEMENTS GT 1) THEN BEGIN

PRINT, "        .",FIELD_NAME + $
"["+STRING(FIELD_ELEMENTS,FORMAT="(I0)") + "]  " + FIELD_TYPE

ENDIF ELSE BEGIN
PRINT, "        .",FIELD_NAME + "  "+FIELD_TYPE

ENDELSE
ENDFOR

HDF_VD_DETACH, VDid
END

;
; List the fields in a given SDS
;
; SDid
;        SD file ID returned by HDF_SD_START
; REF
;        SDS REF returned by HDF_VG_GETTR
;
PRO ListSDS, SDid, REF

SDSidx = HDF_SD_REFTOINDEX(SDid, REF)

SDSid = HDF_SD_SELECT(SDid, SDSidx)

HDF_SD_GETINFO, SDSid, NAME=SDS_NAME
HDF_SD_ENDACCESS, SDSid

HDF_SD_GETINFO, SDSid, NAME=SDS_NAME, DIMS=dimensions, TYPE=field_type, NDIMS=Nd

dim_str = STRING(dimensions,FORMAT='('+STRING(Nd)+'(I0,","))')
dim_str = STRMID(dim_str, 0, STRLEN(dim_str)-1)

PRINT, "     ",SDS_NAME+" (SDS) : "+field_type+" ["+dim_str+"]"

HDF_SD_ENDACCESS, SDSid
END
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;
; List all the PDS data sets in the named HDF file
;
PRO ListPdsDataSets, filename
  Hid = HDF_OPEN(filename, /READ)

  VGs = HDF_VG_LONE(Hid)

  IF VGs(0) EQ-1 THEN BEGIN
   PRINT, "No Data Sets (VGroups)"
  ENDIF ELSE BEGIN
  FOR i=0,N_ELEMENTS(VGs)-1 DO BEGIN
  VGid = HDF_VG_ATTACH(Hid, VGs(i))
  HDF_VG_GETINFO, VGid, NAME=DS_NAME, CLASS=DS_CLASS, NENTRIES=DS_ENTRIES
  IF (DS_CLASS EQ "PDS Data Set Record") THEN BEGIN
   Print, DS_NAME
 ENDIF
  HDF_VG_DETACH, VGid
  ENDFOR
  ENDELSE

  HDF_CLOSE, Hid
END

;
; List all the fields in the named PDS data set in the named HDF file
;
PRO ListPdsDataSet, filename, datasetname

  Hid = HDF_OPEN(filename, /READ)
  SDid = HDF_SD_START(filename, /READ)

  VG_REF = GET_VGROUP_REF(Hid, datasetname)

  IF (VG_REF EQ -1) THEN BEGIN

  PRINT, "Data Set '"+datasetname+"' not found."
  HDF_CLOSE, Hid
  RETURN
  ENDIF

  ListPdsVGroupFields, Hid, SDid, VG_REF

  HDF_SD_END, SDid
  HDF_CLOSE, Hid
END

;
; List all the fields in all PDS data sets in the named HDF file
;
PRO ListPdsDataSetFields, filename
  Hid = HDF_OPEN(filename, /READ)
  SDid = HDF_SD_START(filename, /READ)

  VGs = HDF_VG_LONE(Hid)

  IF VGs(0) EQ-1 THEN BEGIN
   PRINT, "No Data Sets (VGroups)"
  ENDIF ELSE BEGIN
  FOR i=0,N_ELEMENTS(VGs)-1 DO BEGIN
  ListPdsVGroupFields, Hid, SDid, VGs(i)
  ENDFOR
  ENDELSE

  HDF_SD_END, SDid
  HDF_CLOSE, Hid
END


